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1. Introduction 

The PLUREL project – Peri-urban Land Use Relationships – is a large research project funded 
within the 6th framework programme of the European Union. It aims to develop strategies and 
sustainability assessment tools for urban-rural linkages to support the analysis of urbanisation 
trends in the EU so that ways can be identified of both supporting this process and mitigating its 
negative impacts. The main scale of analysis of the project is the so-called Rural-Urban Regions 
(RUR), which has been defined based on the concept of a functional urban region: an urban core 
and its surrounding commuting ring. A RUR can therefore include both rural and peri-urban 
areas as well as the core city.  

MOLAND-LIGHT is jointly developed by JRC and RIKS within the PLUREL project. This is a 
tool with which you can easily assess future land developments in a RUR region of your choice. 
MOLAND-LIGHT is based on the MOLAND land use change model and the METRONAMICA 
modelling framework, but simplified to allow accessibility for the general public. You can 
download MOLAND-LIGHT, select the RUR region of interest and then run simulations until 
2030. Results of each simulation are presented as a series of annual land use maps and several 
environmental and socio-economic indicators. Drivers include time lines for industry and 
commerce area, agricultural and forested area and population. MOLAND-LIGHT does not 
contain the full model and associated data. Instead this is hosted on a central server that the 
system communicates with to run simulations. This reduces the requirements to run a model 
locally. Moreover, data protected by IP rights can be used to run simulations at no charge.  

In order to construct the generic parameter setting for the land use model that would yield 
realistic results for each RUR region, MOLAND-LIGHT was calibrated for selected case study 
areas, representing both urbanized and more rural areas, and independently validated for other 
areas over the same simulation period.  

The MOLAND-LIGHT documentation contains four chapters: 

Chapter 1 Introduction explains the background of the project and the structure of the 
MOLAND-LIGHT documentation. 

Chapter 2 User Manual describes how to use the software of MOLAND-LIGHT. 

Chapter 3 Model description gives the detailed description for each model used in the system. 

Chapter 4 Data preparation and calibration describes data used for the application of 
MOLAND-LIGHT and the calibration procedure and calibration results. 
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2. User Manual 

This chapter describes the user manual of MOLAND-LIGHT, a spatial decision support system 
built with the GEONAMICA framework. MOLAND-LIGHT is developed to model, explore and 
visualize land-use change effects of the different scenarios for urban and regional planning 
applications. 

This manual contains five the sections: 

Section 2.1 “Getting started” explains how to install MOLAND-LIGHT on your computer and 
how to start the program. It also describes the main features of the graphical user interface. 

Section 2.2 Opening a project file describes the primary steps of opening a project file with 
MOLAND-LIGHT and the structures of the main window and the map window. 

Section 2.3 Running a simulation” contains a step-by-step description of how to run the 
simulation in MOLAND-LIGHT. 

Section 2.4 “The MOLAND-Light menu system” offers a systematic description of each option 
in the menu system. 

Through this documentation, for the convenience of the user, a special arrow symbol  is used 
in a step-by-step description of how to complete the action that you can follow along at your 
computer.  For example:  

 Click Open project … on the File menu. 

2.1 Getting started 
This chapter explains how to install MOLAND-LIGHT and its accompanying tools on your 
computer and how to start the program. It also describes the main features of the graphical user 
interface. 

2.1.1 Computer requirements 

MOLAND-LIGHT runs on personal computers with Microsoft Windows XP or Windows Vista 
and equipped with modern Intel or Intel compatible processors. To use MOLAND-LIGHT, your 
computer should have the following hardware components: 

• At least 512 MB of RAM 
• A hard disk with at least 1GB free space 

To make full use of the application, you should have the following software packages installed 
on your computer: 

• Microsoft® Excel (2000 or later) (optional) 
• Microsoft® Picture and fax viewer or Internet explorer (optional) 
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MOLAND-LIGHT is developed for Windows XP and Windows Vista. If you experience 
problems when installing MOLAND-LIGHT on Windows 7, please contact us (see the section 
2.1.9). 

2.1.2 Installing MOLAND-LIGHT and accompanying tools 

The following is a step-by-step description of the installation of MOLAND-LIGHT. The 
installation/uninstallation of MOLAND-LIGHT follows standard Windows procedures. 

If you have a previous version of the MOLAND-LIGHT software installed on your machine, 
you will be asked whether you want to uninstall it first. We recommend uninstalling it. If you 
would want to keep it, make sure to locate the latest version of MOLAND-LIGHT in a separate 
directory. During the installation you may encounter a message asking whether you want to 
keep or replace certain files. We recommend replacing those files for use with MOLAND-
LIGHT. Keeping the old files may cause the software to malfunction. 

To install MOLAND-LIGHT: 

 Step 1. Start Microsoft Windows XP or Vista. 
 Step 2. Double-click on the MOLAND-Light_#.#.#_setup.exe file. The #.#.# refers to the 

version number of the software installation. 
 Step 3. The wizard is started. Press the Next button. 
 Step 4. The wizard asks you to choose the components of MOLAND-LIGHT you want 

to install. Select the MOLAND-Light option and Data option and press the Next button. 
 Step 5. The wizard asks you to choose the install location for the program destination 

folder. The default path for installing the MOLAND-Light programme is C:\Program 
Files\Geonamica\MOLAND-Light. If you want to install MOLAND-Light in a different 
directory, press the Browse... button and navigate to the desire location. Press the Next 
button. Otherwise to cancel the installation process, press the Cancel button. 

 Step 6. The wizard asks you to choose the install location for the Data destination 
folder. The default path is C:\Documents and Settings\User\My 
Documents\Geonamica\MOLAND-Light. If you want to install the Data in a different 
directory, press the Browse... button and navigate to the desire location. Press the Next 
button. 

 Step 7. The wizard suggests adding MOLAND-LIGHT to the new program group 
Geonamica. You are free to create another group or to choose an existing one from the 
list shown. 

 Step 8. Press the Install button. The wizard now installs all the files and data needed to 
run MOLAND-LIGHT into the directories that you have selected. If you selected the 
option in Step 7, the installation programme also creates a programme group named 
Geonamica under Start → Programs that contains a shortcut to MOLAND-LIGHT.  

 Step 9. When the installation is complete, press the Finish button.  
 Step 10. Follow the procedure outlined in the steps 1 to 9 to install the MAP 

COMPARISON KIT.  
 Step 10. You can start to use MOLAND-LIGHT when the installation is finished (see 

the section 2.1.5). The first time you try to open the software you are asked to enter a 
license file. Please select the license file provided to you. 

To uninstall MOLAND-LIGHT: 

 Step 1. Click the Start button in the Windows Taskbar. Move the mouse pointer to 
Control Panel and click. The Control Panel window opens. Select the Add or Remove 
Programs icon by double-clicking on it. Click the Change or Remove Programs button 
in the Add or Remove Programs Properties dialog window. 
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 Step 2. Select MOLAND-LIGHT from the list of applications that can be automatically 
removed by Windows and press the Change/Remove button. 

 Step 3. The Confirm File Deletion dialog window opens. Press the OK button to confirm 
that you want to remove MOLAND-LIGHT and all its files from your hard disk. 

 Step 4. Repeat the steps 1 to 3 to uninstall the MAP COMPARISON KIT. 

2.1.3 MOLAND-LIGHT directory structure 

By default MOLAND-LIGHT is installed in the directory C:\Program Files\Geonamica. Two 
sub-directories are created: MOLAND-Light and Map Comparison Kit.  

Data for MOLAND-LIGHT is placed at a server at JRC. Part of this data is downloaded when 
you create a server project and placed in C:\Documents and Settings\User\My Documents 
\Geonamica\MOLAND-Light.  

The directories for each MOLAND-LIGHT project contain typically the following sub-
directories and files.  

• Animations: animation maps generated during a simulation 
• Data: base maps required to run a simulation and the intermediate output maps for the 

current simulation year 
• Legends: map legends 
• Log: logged maps generated during a simulation 
• *.geoproj: the project file of MOLAND-LIGHT created for the specific case. 

2.1.4 MAP COMPARISON KIT directory structure 

By default the MAP COMPARISON KIT is installed in the directory C:\Program 
Files\Geonamica.  

By default the additional data for the MAP COMPARISON KIT are installed in C:\Documents 
and Settings\User\My Documents\Geonamica\MCK. There are four sub-directories in this folder: 

• Examples: examples developed for the MAP COMPARISON KIT 
• Palettes: palettes legends for the MAP COMPARISON KIT 
• Results: results generated with the MAP COMPARISON KIT 
• Temp: temporary outputs (e.g. reference maps) generated with the MAP COMPARISON 

KIT 

2.1.5 Starting MOLAND-LIGHT 

Once installed, you can start the MOLAND-LIGHT application as follows: 

 Click the Start button on the Windows taskbar. 
 Go to All Programs → Geonamica → MOLAND-Light. 
 Click the GEONAMICA icon . 

Importing the licence file 

The first time you start MOLAND-LIGHT a message window appears asking you to select the 
location of the MOLAND-LIGHT license file.  
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 Click the OK button on the message window. 

A dialog window opens allowing you to navigate to the folder where you put the license file for 
MOLAND-LIGHT that you received from RIKS.  

 Select the license file with the extension *.lic. 
 Press the Open button of this dialog window.  

The licence files will be created automatically in the same directory as Geonamica.exe. After 
this, the system will not ask you again to open the licence file when you start MOLAND-
LIGHT. 

Each time you start MOLAND-LIGHT, the About window appears.  

 Click the OK button on the About window. 

Creating a new project 

As mentioned above data for MOLAND-LIGHT is stored on a remote server. When starting 
MOLAND-LIGHT you can download some region-specific data from this server for 
visualisation purposes and make a connection with the full MOLAND model on this server. . 

 Go to Start → All programs → Geonamica → MOLAND-Light. 
 Click the MOLAND-Light icon.  
 The About window opens. 
 Click on the OK button on the About window. The Open project file dialog window 

opens. 
 Close this window and go to File → Create server project to open the window Create a 

new project. 

 
 In this window you can select your region of choice by selecting the name of the region. 

Regions within a country can be opened by clicking on the  sign before the name of 
the country. The running speed depends on the size of the region. An indication about 
the speed and the area is provided for each RUR region.  

 In the Destination folder text box, you can choose the location to store the application 
data and geoproject file for the selected RUR region. The default path is C:\Documents 
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and Settings\user\My Documents\Geonamica\MOLAND-Light\***, where *** 
represents the name of the selected RUR region. 

 Once you have selected a region and define the path, press OK and a data transfer 
dialogue will show the data that is being downloaded. 

 Press OK once the data transfer is finished and you will find the application to 
your region of choice on your screen. 

 

Opening an existing project file 

If you have already created your project file for the RUR region of interest on your computer, 
you can open it as following steps. For more information about how to create a new project, see 
the section Creating a new project. 

 Go to Start → All programs → Geonamica → MOLAND-Light. 
 Click the MOLAND-Light icon.  
 The About window opens. 
 Click on the OK button on the About window. The Open project file dialog window 

opens. 
 Navigate to the project file that you want to open and double-click on it. 

 
The MOLAND-LIGHT will be started and you will see the GEONAMICA - ### application 
window on your screen, where “###” is the project file name that you selected. 

2.1.6 Screen layout 

When you start MOLAND-LIGHT, the application window opens immediately. This is the 
window in which you will run your models. You can arrange windows as you like in the 
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application window. Before a project file has been opened, the window is empty except for its 
Caption bar, Status bar, Toolbar and Menu bar. The different components of this window will 
be described in the next paragraphs. 

Status bar

Toolbar 

Application Window 

Menu bar Caption bar 

 

Caption bar 

The Caption bar, also called title bar, of the application window shows the name of the 
application: GEONAMICA. As soon as a project file is opened, the title will be extended with the 
name of the project file.  

Menu bar 

The Menu bar of the application window contains the main menu of MOLAND-LIGHT. The 
commands are logically organised in the menu so that you will quickly become comfortable 
with the various functions of the software. The menus are summarised in the table below; 
subsequent sections elaborate on the description. The section The MOLAND-Light menu 
system gives an overview of all menu commands. 

Use this menu To … 
File Manage your project files 
Simulation Control the simulation 
Maps Select and view maps 
Options Customise the workspace and select types of output 
Window Manage your windows on the screen 
Help Look up the system information and find help documentation 

Toolbar 

The Toolbar gives faster access to some of the more frequently used commands that are also 
accessible via the menu.  

 
Button Function 

 Open a project file from the disk 
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Button Function 
 Save a project file to disk 

 Advance the simulation with one simulation step 

 Advance the simulation till the next pause is reached 

 Stop the simulation after the current step is finished 

 Reset the simulation and switch the simulation clock back to the 
initial year of simulation 

A list box next to Integrated scenario is also displayed on the toolbar. All available integrated 
scenarios are displayed on the dropdown list where you can select – that is, load – an integrated 
scenario. When collapsed, the list box shows the name of the active scenario. For the current 
version of MOLAND-LIGHT only a baseline scenario is provided to you. However you can 
create additional scenarios yourself. For more information, see the section Making changes to 
the drivers and saving a scenario. 

The Toolbar also displays the simulation clock. Each time step, the clock is updated to match 
the current value, which means that it increases with steps of 1 year in MOLAND-LIGHT. 

Status bar 

The Status bar is displayed at the bottom of the application window. This area provides 
information to you on your actions while you are working with the application. The Status bar 
describes the following information: 

• When you use the mouse or arrow keys to navigate through menus, it describes actions 
of menu commands. 

• When you press the buttons on the toolbar, it describes actions of this button. 
• When you move the mouse on a raster map, it describes the location of the cell that is 

pointed and the category or value on this cell is displayed in brackets. 
• When you move the mouse on a network map, it describes the x and y coordinators of 

the location. 

The Status Bar also indicates which of the following keys are latched down: the Caps Lock key 
(CAP), the Num Lock key (NUM), or the Scroll Lock key (SCRL). 

2.1.7 System information 

The different commands in the Help menu allow you to look up the system information about 
MOLAND-LIGHT, its commands, options, and tools. You can use the Help menu to select the 
type of information that you want MOLAND-LIGHT to display on the screen. For more 
information see the section Help menu. 

Index 

You can use the Index command to get the opening screen of the on-line help file of 
MOLAND-LIGHT. From the opening screen, you can jump to step-by-step instructions for 
using MOLAND-LIGHT. Double click the topic that you want help on. Once you open the 
Index window, you can click the Close button whenever you want to return to the opening 
screen.  

Licence 

You can use the Licence… command to get the licence information in the Licence window. The 
system allows you to import the licence file by pressing the link of Read a licence file… to open 
the Open dialog window.  
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About 

You can use the About… command to open the About window. You can find here the copyright 
notice and version number of MOLAND-LIGHT that you are using. The latter is important if 
you need assistance with the software from the developers (see the section 2.1.9 If you 
experience problems) or when you request an update of the software. 

 

2.1.8 Closing MOLAND-LIGHT 

You can use the Close project command to close MOLAND-LIGHT. 

 Click the File menu and click Close project. 

If you have a project file open and you have made any changes, one message window will pop-
up and will ask whether you want to save changes before closing.  

 
If you confirm that you want to save changes,  

 Click the Yes button of the Save dialog window to carry out the action of saving and 
closing.  
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More information on saving changes is given in the section Making changes to the drivers and 
saving a scenario of this manual.  

2.1.9 If you experience problems 

If you experience problems installing or running MOLAND-LIGHT, please contact us with the 
version number of the MOLAND-LIGHT that you are using (see the section System 
information): 

Research Institute for Knowledge Systems bv. 

To the attention of Hedwig van Delden 

P.O. Box 463, 6200 AL Maastricht, The Netherlands 

Tel: +31 (43) 3501750 

Fax: +31 (43) 3501751 

E-mail: info@riks.nl 

Website: www.riks.nl 
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2.2 Opening a project file 

This section describes the primary steps of opening a project file with MOLAND-LIGHT and 
the structures of main window and map window. 

2.2.1 Project file and integrated scenario 

It is important to understand how the input data/files and parameters that are required to run 
models in the system are organized in MOLAND-LIGHT. We use the terms project file and 
integrated scenario to describe the different levels of data and file management and parameter 
value settings.  

In the context of this document an integrated scenario is considered to be a set of values for 
each driver in MOLAND-LIGHT (for more information on drivers in MOLAND-LIGHT see 
the section Setting the drivers).  

A project file is used to configure various parts of the simulation and it contains references to 
all the files that are required to run models in the system. The project file used in MOLAND-
LIGHT has the extension *.geoproj. A project file contains at least one integrated scenario. 
The locations of input data and files and parameter values of all integrated scenarios can be 
stored in a single project file.  

For MOLAND-Light an integrated scenario is composed of:  

• The population demand in number of people from 2000-2030. 
• The demand for industrial and commercial area from 2000-2030. 
• The demand for agricultural area from 2000-2030. 
• The demand for forested area from 2000-2030. 

Other drivers are available in the system, but not accessible to the user. For an overview of all 
drivers we refer to chapter 3 Model description. In the full MOLAND version all these 
drivers are accessible to the user. 

2.2.2 Opening a project file 

In the section Getting started we explained how to install and start MOLAND-LIGHT and 
how to create a server project. We assume from now on that you have read this information, 
that you have successfully installed MOLAND-LIGHT on your computer and you have 
knowledge of the different technical terms introduced. 

 Open the geo project file of your interest in MOLAND-LIGHT. For more information 
about how to open a project file, see the section Opening an existing project file. 

Once all files have been loaded, two windows appear in the application window: the Main 
window and the Land use map. These windows cannot be closed! You can move them and 
change their size to organise your workspace, including minimizing or maximizing them, but 
cannot close them. 

Main window 

The Main window is divided into two parts: the navigation pane to the left of the splitter bar 
and the content pane to the right. The navigation pane consists of 3 tabs: Drivers, Indicators 
and Analysis. If one of the tabs is clicked, the list of elements appears below the tab. Clicking 
on an elements, the underlying contents is displayed on in the content pane on the right side 
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of the main window. You can expand one of the tabs by clicking on this tab and you can close 
this tab by clicking another tab. 

 

Navigation pane 

Content pane 

Splitter Bar

Tab 

Section 

 

Map window 

A map window is split into 5 viewing areas, called panes. Panes are separated from each other 
by means of Splitter bars. Map window is used to view indicators, such as the land use map, 
environmental indicators and socio-economic indicators. The Land use map window is a map 
window. We will use the Land use map window as one example of a map window. 

You can open and close map windows, except for the Land use map window. Beware: 
opened maps windows are updated while a scenario runs. This consumes processing time and 
will slow down the overall program. 

You can move the splitter bars to change the size of a pane. 

 Position the cursor over the splitter bar.  
 Hold the left mouse button down while dragging the splitter bar and change the size 

of the panes accordingly. 



 

 14

 
Legend pane 

Map paneOverview pane

Splitter bar

Layer manager pane 

Tools pane 

Layer visibility 

Scroll bar

 
Splitter bar 

Panes are separated from each other by means of Splitter bars. You can move the splitter bars 
to change the size of a pane.  

Map pane 

The map pane is located in the middle of the Land use map window and displays a land use 
map for the modelled region. Specifically, the land use map for the current simulation year is 
shown. The map pane is equipped with both vertical and horizontal scroll bars. If you cannot 
see all the complete contents of the map pane, use the Zoom tools in the tools pane to adjust 
the image appropriately, e.g., zoom in/out, pan horizontally/vertically. 

Land use information is presented for each grid cell. The cell states on the map represent the 
predominant land use on that location. When you click a location on the map, the cell location 
(row, column) and the predominant land use on this location will be displayed in the right side 
of the status bar. To the left of the map pane is a legend pane that displays the land use legend. 
When a simulation is running, the Land use map window will be updated after each time step. 

Right-clicking on the map pane, the context menu appears with two options: Cell information 
and Copy as bitmap.  

 Click on Cell information. The name of the land use on the pointed location appears. 
 Click on Copy as bitmap. The screenshot of the map displayed in the map pane will 

be temporarily stored on the clipboard.  
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You could inspect the information on a specific location by activating the Inspect button and 
right-clicking in a map. The information of the boundary map and the selected map for that 
location will be displayed in a yellow box. For more information about the Inspect tool, see 
the section Grid tools. 

Legend pane 

The legend pane is displayed in the upper-left portion of the Map window. It shows the legend 
of the map selected in the Layer Manager (explained below). For example, if you select a land 
use map, the legend pane shows the legend of land uses. 

The land use is subdivided into 3 types: Vacant, Function, Feature. In the legend of the map, 
the Vacant states appear at the top of the list, the Function states appear in the middle of the 
list and are underlined, and Feature states appear at the bottom of the list. These three 
different land use types are explained later in the section Description MBB Land use. 

Overview pane 

The overview pane is displayed in the lower-left portion of the Land use map window. It 
displays the entire modelled region. A wire-frame rectangle outlines the portion of the region 
that is currently displayed in the map pane. You can move the wire-framed rectangle by 
placing the mouse pointer inside it and clicking and holding the left mouse button. Moving 
the rectangle moves the map in the map pane accordingly.  

Layer manager pane 

The layer manager pane is displayed in the upper-right portion of the Land use map window.  
It lets you turn map layers on and off in the map pane. In the example above, three maps are 
available: Land use map and Region boundaries. Often other maps will also be available. 

Clicking on the button to the left turns map layer visibility on   or off  . 

Button Function 

 Turn on layer visibility 

 Turn off layer visibility 

MOLAND-LIGHT allows you to view multiple layers simultaneously. Note that the 
boundaries map layer is displayed in all Map windows. 

Tools pane 

The tools pane is displayed in the lower-right portion of the Map window. It shows the tools 
for viewing and editing selected map layers and includes the Zoom tools, Grid tools, and 
Network tools. You can open the context menu of the tool pane by right-clicking, which 
controls how tools are arranged on the desktop.  
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Edit, check and save grid map 

Expand all the tools 
in map window 

Close all the tools in 
map window 

Change the manner in which different 
maps of map window are displayed  

Edit and display network map 
 

Zoom tools 

Use the Zoom tools when you would like to see a location in more detail.   

Button Function 

 Zoom in 

 Zoom out 

 Pan 

 Zoom to Selected  

 Fit Whole Map to Window 

When you activate one of these buttons and click the mouse pointer on the map, you can carry 
out the selected zoom option. 

Grid tools 

Use Grid tools to edit and view the information of the editable raster or grid maps that you 
have selected. In MOLAND-LIGHT, all maps are not editable and only Inspect and Save 
Grid buttons are enabled.  

Button Function 

 
Change the pointer to a pen. The pen is used to pick a value from the 
legend and enter it in a cell on the map. This button is not enabled in  
MOLAND-LIGHT. 

 
Change the pointer to a bucket. The bucket is used to pick a value from 
the legend and enter it in larger, contiguous areas of the map. This 
button is not enabled in MOLAND-LIGHT. 

 Display the information of the selected map on the map windows 

 
Copy the shape and colour information in the selected area from 
another grid layer to the current grid layer. This option is not available 
in MOLAND-LIGHT.  

 
Copy the colour information on the selected area from another grid 
layer to the current grid layer. This option is not available in 
MOLAND-LIGHT. 

 Save the grid map that you select 

2.3 Running a simulation 
The Main window of MOLAND-LIGHT provides access to setting the drivers for integrated 
scenarios and analysing the impacts of these scenarios. It follows the steps Drivers, Indicators 
and Analysis, each of which is explained in more detail below.  
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2.3.1 Overview of working with MOLAND-LIGHT 

Step 1: Setting the drivers 

When clicking on the Drivers tab in the navigation pane on the left hand side of the window 
you get access to the different types of drivers: Population, Industry and Commerce area, 
Agriculture area and Forest area. Steps required to view or to change driver settings are 
described in the sections Setting the drivers and Making changes to the drivers and saving a 
scenario. 

Step 2: Running the simulation 

Obviously you cannot investigate all land use changes, as well as other available information, 
while the system is running. Therefore you have several possibilities to export intermediate 
and final results of the simulation: 

• You can select an individual map and export it to analyse it. 
• You can create logged maps using log maps function which could be analysed 

afterwards in the MAP COMPARISON KIT (part of the MOLAND-LIGHT package) or 
common GIS packages. 

• You can make an animation that shows you the land use, indicators or other model 
results change over time. You can open the animation in a viewer, but can also 
incorporate them in presentations. 

• You can create a link to Excel through which all selected model block results are 
directly written to Excel. This can be used for analyses and post-processing 
afterwards. 

Before running the simulation you can decide which results you would like to save to disk. 
For details about running the simulation and saving results, please refer to the sections 
Running a scenario and Saving results. 

Step 3: Visualising results 

After the simulation is finished, MOLAND-LIGHT offers several options to analyse results. 
The first option is to visualise the land use map and the indicators that are being calculated by 
the system. The indicators are organised in two groups: 

• Environmental indicators  
• Social-economic indicators  

On a yearly basis each of these indicators is calculated. You gain access to the indicators by 
clicking the Indicators icon in the main window. Steps to take in visualising indicators are 
described in the section Viewing results. 

Step 4: Analysing results 

The final step of the impact assessment study is to analyse results within an integrated 
scenario (e.g. the temporal evolution of an integrated scenario) or to compare a set of 
integrated scenarios. In step 2 of the assessment you have selected what type of information 
you want to save for analysis. In this step you carry out the analysis thereof. The Excel files 
that have been created can be analysed with Excel; the animations can be shown in a viewer; 
and the logged maps that have been saved in log-files that can be opened in the MAP 
COMPARISON KIT, which can be opened when going to the Analysis tab of the Main Window.  
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2.3.2 Setting the drivers  

In MOLAND-LIGHT, input is given in graphs. The following sub-sections describe how to 
edit input.  

The graph editor is used in MOLAND-LIGHT to define the demands for population and land 
use (industry and commerce, agriculture and forest) in the driver section. At the left side of 
the graph editor window is the graph display area. To the right is the x/y value pairs list, 
showing you the x/y value of the graph. 

Graphs in MOLAND-LIGHT can be edited in the Graph display area part which is indicated 
with the white background. We apply a linear interpolation between different points. This 
means that when you add or change the value of one point MOLAND-LIGHT will 
automatically interpolate between this point and its neighbour points. 

 

Graph display area X/Y value pairs list

Context menu 

 
 Go to the driver of your interest on the left side of the Main window. 
 On the right side of the Main window, move the mouse pointer to the abscissa position 

for which you want to enter a new ordinate value.  
 Right-click and select Add data point… from the context menu o add a point to the 

graph. The Enter new data point values dialog window opens. 
 Select the year for which you want to add a point from the dropdown list next to X 

and a new value in the text box next to Y. 
 Press the OK button in the Enter new data point values dialog window. 

 
As a result a little circle will be drawn and line segments will connect the new point to the 
nearest points left and right in the graph created thus far. There are two ways to reposition a 
point in the graph display area: 
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 Left-click the point in the graph display area. Hold the mouse button down while 
dragging it to its new position. Then release the button. 

 Move the mouse pointer to the point that you want to reposition and right-click.  
 Select the Edit from the context menu. The Edit data point dialog window opens 

where you can select the abscissa (x) and enter ordinate (y) values. 

 
You can remove a point again from the graph as follows: 

 Right-click the point on the graph and choose Delete from the context menu. 

You can change the range of the x- and y-axis as follows. 

 Right-click in the graph and select Options from the context menu. The Graph options 
dialog window opens. 

 Enter the new value for the lower and upper bounds of the x- and y-axis. 

 
You can copy the graph as image or as text to the clipboard. 

 Right-click in the graph and select Copy as image from the context menu. The graph 
is copied as image and stored in the clipboard. 

 Right-click in the graph and select Copy as text from the context menu. The x/y 
values on the graph are copied as texts and stored in the clipboard. 

2.3.3 Making changes to the drivers and saving a scenario 

Changes to drivers can be made in the driver section of the main window. 

 Change one or more drivers by setting adding or changes the values of the bullets in 
the graphs as described in the section Setting the drivers. 

Save a project file 

The Save project command on the File menu allows you to save changes to driver values and 
to save the simulation output for the current simulation year in the current project file.  
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 Click the Save project command on the File menu. The Save project dialog window 
opens. 

 Enter a new integrated scenario name, e.g. Scenario 1 in the text box next to 
Integrated scenario name. 

 Enter a description in the text box next to Integrated scenario description to reflect 
the changes you have made compared to the original baseline scenario. 

 Select Save as new scenario from the dropdown list next to Land use demand 
scenario.  

 Click the Details… button to open the Scenario details dialog window.  
 Enter a descriptive name, e.g. Land use Scenario 1 in the text box next to Name, and 

enter a short description in the text box next to Description  
 Click the Save button at the bottom of the Save simulation window to save the 

integrated scenario. You will see the name of your integrated scenario appear in the 
toolbar. 

Save a project file as 

The Save project as… command on the File menu allows you to save the changes to data/files 
and parameter values and to save the simulation output for the current simulation year with 
another project file name. The same as saving project, the action of saving project as will be 
completed by the combination of saving external files with all integrated scenarios under a 
different name.  

 Click the Save project as… on the File menu. The Save project file dialog window 
opens. 

 Enter a new project file name, e.g. Arr_Arlon alternative.geoproj.  
 Press the Save button on the Save project dialog window. The Save project dialog 

window opens. 
 Enter a new scenario name in the text box next to Integrated scenario name. 
 Enter the description text in the text box next to Integrated scenario description. 
 Select Save as new scenario from the dropdown list next to Land use demand 

scenario.  
 Click the Details… button to open the Scenario details dialog window.  
 Enter a new descriptive name and a short description text in the Scenario details 

dialog window. 
 Press the Save the button at the bottom of Save project dialog window to finalize 

saving the project file as Arr_Arlon alternative.geoproj. 

You will see the Arr_Arlon alternative displaying on the top-left of the Geonamica window. 

2.3.4 Running a scenario 

Once the Main window and the Land use map window have been opened, the program has 
read the default values for all the parameters as well as the initial values for all the state 
variables of models. The program is ready to run a scenario. You can run a scenario with the 
control buttons on the toolbar or with the commands on the Simulation menu.  
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Active integrated scenario Simulation clock 
 

On the toolbar as depicted in the figure above, the left-most box displays the active integrated 
scenario. The right-most box displays the Simulation clock, which indicates the progress of 
the simulation: the year until which the simulation has run.  

It is essential for the MOLAND-LIGHT application to communicate with the JRC server 
when you run a scenario on your local computer. Therefore, it is important to make sure that 
your computer is connecting to the internet. Otherwise, you will get an error message. 

Active integrated scenario 

Before you start running the simulation, you need first to select one integrated scenario as the 
active integrated scenario. 

 Click the dropdown list next to Integrated Scenario on the toolbar. All the available 
integrated scenarios will be displayed on the list. 

 Select your integrated scenario of interest from the list, for example, the Baseline 
integrated scenario. Note that the applications stored at the JRC server only include a 
baseline scenario. You can create alternative scenarios in the way described in the 
previous sections. 

After you select the integrated scenario from the list, the system loads the integrated scenario 
immediately as the active integrated scenario. When collapsed, the list box shows the name of 
the active integrated scenario. You can easily switch to another integrated scenario from the 
active integrated scenario dropdown list on the toolbar.  

Note that loading the active integrated scenario means loading the input data/files and 
parameters defined in this integrated scenario to the graphic user interface. In this case, the 
models have not been updated to the changes. You can use the Update, Step, Run and Reset 
command to update the models of the system to the changes. 

Reset 

You can switch the simulation clock back to the start year of the simulation by pressing the 
Reset button on the toolbar or by using the Reset command on the Simulation menu. This 
action resets all the parameters and maps to their initial value. The changes that you made to 
the parameters and maps, which include the changes to the initial values and initial maps, are 
affected by resetting the simulation because all of them are recalculated for the start year.  

Whenever you change the initial values or initial maps for the start year, you need to reset to 
perform the changes. 

Update 

To update the models of the system to the changes that you made in the user interface for the 
current simulation year (hence, except for the changes to the initial values or initial maps), 
you can use the Update command on the Simulation menu. The action of updating will not 
take into account the changes that you made to initial values or initial maps. To that effect, 
you can use Reset or click the Step or Run button on the toolbar. After the model has been 
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updated, the variables that are affected by changes are recalculated and the updated output 
will be displayed via the user interface.  

You can use the Update command to have the model perform the changes that you made 
without advancing the simulation clock. This is especially useful to test the immediate effects 
of a newly entered (set of) parameter(s) before running the simulation. 

Step 

To verify that the program is ready to run, you can use the Step command on the Simulation 
menu or press the Step button on the toolbar. Once pressed, MOLAND-LIGHT goes through 
a number of essential phases, such as the updating the models and testing of its input, which 
are of no direct interest to the user before it makes one simulation time step. This takes a 
while. You will notice that the action is finished when the simulation clock changes to next 
simulation year and the land use map in the Land use map window is updated. If you select 
the Step command, the models will be automatically updated if this has not been done 
manually. 

Run 

To perform a simulation for the whole simulation period, you can use the Run command on 
the Simulation menu or press the Run button on the toolbar. The simulation starts running 
until the next pause moment has been reached and the progress can be followed as the Land 
use map window and the simulation progress clock are updated on a yearly basis. 

Unless other pauses are set (see the section Pauses), the simulation will halt at the end of the 
simulation period. If you select the Run command the models of the system will be 
automatically updated if this has not been done manually. 

Stop 

You can pause a running simulation by pressing the Stop button on the toolbar or using the 
Stop command on the Simulation menu. When the simulation is stopped, it finishes the 
calculations for the current simulation year and stops. The simulation continues when you 
select the Step or Run. You can also pause the simulation at predefined instances (see Section 
Pauses). 

Pauses 

To set the pauses in the simulation, you can use the Pauses… command on the Simulation 
menu. When Pauses… is selected, the Pause Settings dialog window opens. You can use the 
Run command on the Simulation menu or press the Run button on the toolbar to advance the 
simulation again until the next pause is reached. 
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Display format 

In the Display format pane of the Pause settings window, you can define the display format of 
pause tabs by clicking the radio button in front of the format that you want to display. When 
you switch the format, the list of pauses is displayed accordingly.  

Be aware that the Display format that you defined in the Pause settings dialog window will 
be used for the integrated time in the system, such as the time format in the Log maps on the 
Options menu and Simulation clock on the toolbar. 

Add 

You can add a new pause by clicking the Add button on the top-right of the Pause Settings 
dialog window. Enter the year in which you want to halt the simulation in the text box next to 
Time and then press OK. The pause at this year will be added to the Pauses list. 

 
Generate 

You can predefine pause instances by using the Generate command. The Generate pauses 
dialog window opens when you press the Generate button of the Pause settings window. 
You can enter the interval start time, the interval end time and the interval step length in the 
Generate pauses dialog window and press OK button. The pauses are generated and 
displayed on the pauses list of the Pause Settings dialog window. 
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Remove 

You can remove a pause by selecting the one that you want to remove and clicking the 
Remove button on the right hand side of the Pause settings window. 

2.3.5 Saving results 

Write to Excel 

You can select the Write to Excel… from the Options menu to establish (or interrupt) a link 
between MOLAND-LIGHT and a Microsoft Excel workbook. A new window appears as 
shown below. MOLAND-LIGHT is sending model output to the Excel Workbook while the 
simulation is advancing.  

 
The data transferred to the Excel workbook shows results for population, cell counts for 
industry and commerce, agriculture area and forest area..  

Defining Excel sheet name 

The list of predefined output options are displayed per model block from which they origin in 
the Model block name column on the top pane of the Write to Excel settings window. The 
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system will only make links for the model blocks which are configured in the column of 
Excel sheet name.  

 Select the cell next to this model block to enter a name by clicking on it. 

If you want to use the model block as the Excel sheet name, you can use Ctrl+c and Ctrl+v on 
your keyboard to do so. 

 Click on the model block name for which you want to make link to Excel sheet. 
 Press Ctrl+c on your keyboard. 
 Click the corresponding cell in the column of Excel sheet name.  
 Press Ctrl+v on your keyboard. 

The names that you add in the Write to Excel settings window will be displayed as the names 
of the sheets in Excel. 

 
Defining writing moments 

While a simulation is advancing, the system only writes model output for the moments that 
are determined in the Writing moments pane on the lower-left part of the Write to Excel 
settings window. You can adjust the list of writing moments by using the Add… button, the 
Generate… button, the Delete button and the Reset button. 

You can add a single moment as follows. 

 Click the Add… button. The Add write moment dialog window opens. 
 Enter the moment in the text box next to Time for which you want to display the 

model output in the Excel workbook. 
 Press OK.  

The write moment at this year will be displayed on the Writing moments list immediately. 

 
You can define write moments at regular intervals as follows: 
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 Click the Generate… button. The Generate moments dialog window opens. 
 Enter the interval start time, the interval end time and the interval step length in the 

Generate moments dialog window. 
 Press OK.  

The moments are generated and displayed on the Writing moments list immediately. 

 

 
You can easily delete one or several writing moments by selecting the moments that you want 
to remove and clicking the Delete button. If you are not satisfied with the moments that you 
just created, you can undo the configuration by clicking the Reset button. This action will 
reset all writing moments to the value they had when you last opened the Write to Excel 
settings window. 

Starting writing 

To finalise the link between MOLAND-LIGHT and Excel workbook, you can click the Start 
writing button on the right-low pane of the Write to Excel settings window. The Write to Excel 
settings window closes automatically. A link between MOLAND-LIGHT and Excel 
workbook is established after this action, although you cannot see this directly on your screen.  

 
While this function is activated, Write to Excel on the Options menu is preceded with a tick 
mark.  

 
Now you can run the simulation with the link to the Excel by clicking the Run button on the 
toolbar. Note that the system only starts writing results to Excel from the first writing 
moments after the current simulation year. For example, if the current simulation year is 2005, 
you press the Start writing button and then press the Run button. The first writing moment will 
be the year 2008 which is the first writing moments after the current simulation year (2005) as 
depicted in the figure below. 
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If you want to write results to Excel from the start year of the simulation after setting the 
writing moments, you can follow the steps below. 

 Click the Start writing button of the Write to Excel settings dialog window. 
 Click the Reset button on the toolbar. 
 Click the Run button on the toolbar. 

Saving settings  

You can change settings for writing to Excel while the simulation is running.  

 Click the marked Write to Excel option on the Options menu.  

The Write to Excel settings window opens again. Now the Save settings, and the Open Excel 
workbook buttons become enabled on the right-low pane of the window. You can only change 
the settings of in the Writing moments but you cannot change settings in the Excel sheet name 
pane that are greyed-out.  

 
It is very important to press the Save settings button to finish the adjustments while keeping 
the system writing model output to the Excel workbook. Only the data for moments, which 
are later than the current simulated time, will be written to the Excel workbook. The function 
of Write to Excel on the Options menu is still preceded with a tick mark.  

If you press the Open Excel workbook button, the function of Write to Excel will be switched 
off. You can always check whether the link to Excel is activated from the tick mark Write to 
Excel on the Options menu. 

Opening Excel workbook 

To stop writing to Excel and view the Excel workbook, you can press the Open Excel 
workbook button. The Excel workbook opens immediately, showing the worksheets with the 
names that you defined. You can use it now for further analysis of the simulation data. 
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Note that in order to establish a successful link, it is required that Microsoft Excel is installed 
on your computer. If MOLAND-LIGHT cannot find Excel, the Write to Excel on the Options 
menu will be greyed out.  

Log maps 

You can use the Log maps… command on the Options menu to store all the maps produced 
by the system in the form of .rst files. The system generates a Log File (*.log) automatically 
when you use the Log maps… command. In the Log File, all the maps that you selected to log 
are included.  

You can analyse these logged maps files *.log with the MAP COMPARISON KIT – see the 
section Analysing results. 

When Log maps…command is selected the Log settings dialog window opens. 

 
Selecting maps 

In the Maps to log pane, a tree of maps is available, which is organized by the type of 
information on the map. You can expand or collapse the branches of map tree by moving the 
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mouse over the name of group and double-click or moving the mouse over the box in front of 
the group and left-click.  

In this tree, you can indicate which maps you want to store. You could select/unselect all 
maps in a sub-model – e.g. all accessibility maps or all maps in the land use model – or in the 
entire model by clicking on the corresponding check box. 

 Click the check box on the left side of the name of the map that you want to log.  

Maps are selected for logging if the check box is checked with a green mark. 

Changing path of log maps 

MOLAND-LIGHT will generate a log file with the extension ###.log containing the logged 
maps. You could specify the path and the name of the log file in the Log folder pane. The 
logged maps will be stored in the folder named with ### in the path you specified. For 
example, if you use Baseline.log as the name of the log file, all the logged maps will be stored 
in the folder of Baseline on your computer. 

It is important to specify the path and give a descriptive name for the log file based on the 
scenario that you are running. Otherwise, previously logged maps will be overwritten. 

You can modify the path and the name of the log file as follows: 

 Click the browse button on the right side of the text box. The Select MCK log file 
window opens.  

 Navigate to the location that you want to store the logged maps and click the Open 
button.  

 Enter the name of the log file next to File name.  
 Press the Save button. 

 
Editing log moments 

In the Log moments pane on the lower-left part of the Log settings window, you can specify 
moments for which maps will be logged. First of all, you can select the time format used in 
the file names of the logged maps from a number of presets, including the year, the full date 
and the full date and time. To do so, select the format of interest from the dropdown list next 
to Time format. 

You can make a list of logging moments by using the Add…button, the Generate… button, 
the Delete button and the Reset button of the Log moments pane. This works similarly to 
Defining writing moments in the Write to Excel.  

The system allows you to change the display format on the Add log moment and Generate log 
moments dialog windows by using the Pauses…command in the Simulation menu (see the 
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section Pauses). You can change the settings in the Maps to log pane and the settings of in the 
Log moments pane while the simulation is still advancing.  

Turning logging on 

To activate the logging functions, you have to press the Turn logging on button on the lower-
right pane of the Log settings dialog window. The selected maps in the tree of maps will be 
stored in the path you specified. The function of Log maps in the Options menu is preceded 
with a mark. 

 
If there is no map selected, you are not able to turn the logging function on. A message 
window depicted as figure below appears. 

 
Saving settings 

You can finish any adjustments made in the log settings by clicking the Save settings button. 
Only the maps for the moments, which are later than the current simulated time, will be 
logged. The function of Log maps on the Options menu is still indicated with a tick mark 
when it is activated.  

When the function of log maps is enabled, the selected maps for the selected log moments 
will be logged while the simulation is running. 

Turning logging off 

You can stop the logging by clicking the Turn logging off button on the lower right pane of the 
Log settings dialog window. The function of Log maps on the Options menu is now displayed 
without a tick mark. 

 

Animate maps 

It is also possible to make movies of maps during a simulation and store them for later use. To 
that effect, you can use the Animate maps… command from the Options menu. When this 
command is selected the Animation settings dialog window opens. Animations are stored in 
the form of .gif files. 
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Selecting maps 

In the Maps to animate pane, a tree of maps is available, which is organized by the type of 
information on the map. You can expand or collapse the branches of map tree by moving the 
mouse over the name of group and double-click or moving the mouse over the box in front of 
the group and left-click.  

In this tree, you can indicate which maps you want to store. You can select/unselect the land 
maps and all indicator maps by clicking on the corresponding check box. 

 Click the check box on the left side of the name of the map that you want to animate.  

Maps are selected for animation when the check box is checked with a green mark. 

Changing the path of animated maps 

The program automatically sets the location where the animations are stored as well as the file 
name in the Animation directory text box. You can change the filename and location by 
pressing the browse button on the right hand side.  

When the Animate maps function is activated in MOLAND-LIGHT, this is indicated with a 
mark in front of this option on the Options menu. If no map is selected in the Animation 
settings dialog window, no animations will be generated during the simulation. 

When animating maps, the maps are transformed into an image (the animations are a number 
of images glued together into one file). When the Animate maps function is activated in the 
MOLAND-LIGHT, this is indicated with a mark in front of this option on the Options menu. 
If no map is selected in the Animation settings dialog window, no animations will be 
generated during the simulation, the mark indicates otherwise. 

 
You can view the animations in most recent Internet browsers as well as some graphics 
packages equipped with an animation facility. 

2.3.6 Viewing results 

The most important results calculated by MOLAND-LIGHT are provided in maps: land use 
map and indicators.  
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Viewing the current land use map 

The first result of MOLAND-LIGHT is the land use map for the current simulation year. The 
land use map is shown when you start up the system and updated during each simulation step. 
You can view the land use map via the Land use map window.  

 
For more information about the general characteristics of a map window in MOLAND-
LIGHT; see the section Map window. 

Visualising indicators 

The second result of MOLAND-LIGHT is the calculated indicators for the current simulation 
year. In MOLAND-LIGHT, the basic output produced is maps. However, these maps are not 
always easy to interpret at first instance. For that reason, MOLAND-LIGHT computes a range 
of indicators as well. An indicator in this context is a measure to make a particular 
phenomenon perceptible that is not –at least not immediately– detectable.  

You can access the indicators via the Indicators tab in the Main window. 

 
Some of these indicators describe a state or a condition and others show a change over time. 
The first set of indicators for the start year is already available when starting up the simulation; 
for the second set the simulation requires a step first; otherwise no change can be calculated. 
While the Forested areas shows both the condition and the change. 

Indicators that describe a state or a condition are: 
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• Soil sealing 
• Forested areas (category: Forest) 
• Urban clusters 
• Distance from residential to work 
• Distance from residential to recreation 

Indicators that show a change over time are: 

• Expansion of urban areas 
• Abandoned land 
• Forested areas (category: Deforestation) 
• Forested areas (category: Afforestation) 

To view the maps of the indicators which show a change over time, you should first press the 
Step button or the Run button on the toolbar. In the start year of the simulation, the maps of 
the indicators which show a change over time are displayed as blank. 

You can visualise indicators at any point in time (any year) during the simulation. To 
visualise an indicator, take the following steps: 

 Go to the Indicators tab of the Main window. 
 Select the sections in the navigation pane on the left hand side of the Main window the 

type of indicator you are interested in. 
 Click on the Show map button next to the indicator of interest. A map window opens 

where the name of the indicator is displayed in the title of the map window. 

 
All spatial indicators can be stored in log maps and as animations. Please refer to the section 
Saving results to for more information about how to create log maps and animations. How to 
compare indicators over time and between scenarios is described in the section Analysing 
results. For the algorithms of environmental indicators, see section 3.2 MBB Spatial 
indicators.  

2.3.7 Analysing results 

The final step of the impact assessment study is to analyse results within an integrated 
scenario (e.g. the temporal evolution of an integrated scenario) or to compare a set of 
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integrated scenarios. For further processing of the numerical results you can use a spreadsheet 
programme such as Excel. In order to analyse spatial results (maps) more carefully it is often 
helpful to analyse them pixel by pixel or to compare only the land use type you are interested 
in. For this MOLAND-LIGHT links to the MAP COMPARISON KIT, abbreviated to MCK. 
The MCK comes with its own dedicated manual. It explains the use of the MCK and 
describes in detail how you can analyse and compare logged maps generated by MOLAND-
LIGHT in an interactive manner. This section will provide a brief overview of the MCK and 
the way results maps from MOLAND-LIGHT can be compared with this tool. 

Short overview of the MCK 

An overview of the MCK looks as depicted below.  

1st Map 

Menu bar Toolbar 

2nd Map Result map 

Comparison settings 

Result statistics 

Work pane 

 
The MAP COMPARISON KIT application window consists of the Menu bar, the Toolbar and 
the Work pane. You can simultaneously open different windows for maps and statistics. 
Furthermore, it is possible to keep the Comparison Settings dialog window opened while 
working with the tool: 

• The 1st Map window contains the first map to compare/analyse. To change the 
contents of toolbar the 1st Map window, choose another map from the dropdown list 
next to the 1-button on the. If the 1st Map window is not open yet, then you can do so 
by clicking the 1 button. 

• The 2nd Map window contains the second map to compare/analyse. To change the 
contents of the 2nd Map window, choose another map from the combo box next to 
the 2-button on the toolbar. If the 2nd Map window is not yet open, then you can do 
so by clicking the 2 button. 
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• The Result map window contains the result map. This map shows the spatial result of 
the last performed map comparison. Depending on the selected comparison method 
the results are presented in a continuous scale or a nominal scale. 

• The Result statistics window contains the statistical results of the last performed map 
comparison. 

• The Comparison settings dialog window allows setting and viewing the settings 
belonging to the active comparison method. 

Comparing the land use maps for different years of one integrated scenario 

First we analyse how the maps of the Baseline integrated scenario changes over time: 

 Go to the Analysis tab in the navigation pane on the left hand side of the Main window 
of MOLAND-LIGHT. 

 Press the Start MCK button in the content pane on the right hand side of the window. 
The Open dialog window of the MCK opens.  

 Click the Cancel button in the Open dialog window. 
 Select the Open option on the File menu of the MAP COMPARISON KIT. The Edit Log 

File dialog window of the MCK opens. 

 
 Click the New theme item and give a name Land use for the new group of maps that 

you are going to import. 
 Press the Import… button in the Edit Log File window. The Import… dialog window 

opens.  

You will find the logged maps (*.rst) of the baseline scenario in the folder of \My documents\ 
Geonamica\MOLAND-Light\Log by default or in the specific folder that you defined in the 
section Log maps. 

 Select the *.rst in the Files of type box. 
 Select the map that you want to compare. Repeat this step to import all the maps that 

you want to compare. The imported maps are displayed on the Land use list. 
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 Click the OK button in the Edit Log File dialog window. A Save as dialog window 
opens where you are required to name and save the project file of MCK in *.log 
format. Name the log file and press the OK button in the Save as window. 

A *.log file is actually a file which contains a reference to one or several maps that you want 
to perform comparisons. When you open a log file in MCK, you can easily load all maps 
referred in the log file. 

 Select the maps that you want to analyse from the dropdown list in the toolbar next to 
 and next to , for instance, Land use map_2006.rst as Map 1 and Land use 

map_2030.rst as Map 2. 
 Click the 1 button to open the land use map for 2003 in the 1st Map window and click 

the 2 button to open the land use map for 2030 in the 2nd Map window. 

Note that the current legends in the left side of the map windows are still set by default. There 
are two ways to change the legend files of the land use maps that you imported in the MCK. 

• Edit the legend one by one in the Legend Editor by clicking on the Legend… option 
on the Edit menu on the menu bar. For more information, we refer the MCK user 
manual. 

• Copy the content of the land use legend file \My 
documents\Geonamica\Metronamica\Legends\LandUse.txt that you used in 
METRONAMICA to the legend file \Legends\Land Use.txt that the Land use theme in 
MCK is used. This way you can have the same legend for the land use maps in MCK 
as the one used in METRONAMICA. 

Now you are going to set comparison algorithm. 

 Click the Algorithm button  on the toolbar. The Comparison algorithm dialog 
window opens. 

 Click the checkbox in front of Per category in the Comparison algorithm window. 
Press the OK button on the top-right of the window. 

 Now to choose which land use you want to investigate, click the Parameters button 
 on the toolbar. The Algorithm settings: Per category dialog window opens. 

 Select Agriculture land use and click the OK button in the Algorithm settings: Per 
category dialog window. 

 Click the Compare button  on the toolbar. Now the Result map: Per category 
Agriculture opens where there are 4 options available: in none of the maps, in both 
maps, only in map 1 and not in map 2 and only in map 2 and not in map 1. 

Besides the land use map, you can also analyse other categorical maps (e.g. Urban cluster) in 
the same way. To do this, import and select another type of categorical map from the 
dropdown list on the toolbar and repeat the steps above. 

If you are interested in looking at the statistical information regarding changes, you can go to 
the option Result statistic on the Options menu or press the Statistics button  on the toolbar. 

Numerical maps, like the accessibility maps, suitability maps, value at stake maps etc that 
show numerical values, can be compared using measures that can be found under the 
Compare numerical maps in the Comparison Algorithm window. 

Select the total potential maps for certain land use (or any other numerical map) in the 
dropdown list on the toolbar. 

 Click the Algorithm button on the toolbar. The Comparison Algorithm dialog window 
opens. 

 Select Comparison Algorithm → Compare numerical maps → Cell by cell → b-a. 
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 Investigate changes in total potential for certain land use over time. 

 
In this exercise you have investigated the actual land use change over one simulation. A more 
interesting investigation would be to compare the results of two different scenarios. This you 
will do next. 

Comparing output maps of integrated scenarios 

The simulation that you used until now, the Baseline integrated scenario, represents an 
extrapolation of observed historic developments combined with expected future developments. 
You can say it shows a ‘business as usual’ scenario that incorporates the processes as they are 
observed in the past and expected for the future. However, the full power of a spatial decision 
support system lies not in this baseline integrated scenario but in investigating different 
integrated scenarios and analysis of scenarios and effects of policy measures. Hence it helps 
you to answer “what if. . . .” type of questions.  

In this exercise you will compare an alternative integrated scenario with the Baseline 
integrated scenario. For this we will again use the MCK.  

To incorporate the logged maps from the alternative integrated scenario,  

 Go to the option Log file… on the Options menu. The Edit Log File dialog window 
opens. 

 Press the Import… button on the right hand side of the Edit Log file window. 
 Select the *.rst file type and select the logged maps of your integrated scenario of 

choice. 
 Click the OK button in the Edit Log File window. 

Instead of comparing the start and end map of the simulation within one integrated scenario 
you can investigate the difference between two integrated scenario results. We will again do 
this per category. 

 In the MCK select the Baseline integrated scenario result map in 2030 as Map 1 and 
the alternative integrated scenario result map in 2030 as Map 2.  

Now you can investigate the categorical maps in more detail.  

 Click the Algorithm button on the toolbar. The Comparison algorithm dialog window 
opens. 

 Click the checkbox in front of Per category in the Comparison algorithm window. 
Press the OK button on the top-right of the window. 
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 Click the Parameters button on the toolbar.  
 Select your land use of interest in the Algorithm settings: Per category dialog window. 

Now you can investigate the difference between the result maps of two integrated scenarios. 

2.4 The MOLAND-LIGHT menu system 

This section explains the different functions that are available from the MOLAND- LIGHT 
menu system. Some GEONAMICA functions are not available in MOLAND- LIGHT. These 
are greyed out; they are visible in the menu in a light grey colour, but they do not result in 
further actions when invoked. Consequently, these functions are not described in detail in this 
section. 

Other functions are only accessible when they are relevant. For instance, the Stop command 
in the Simulation menu is only accessible when the simulation is running. 

The menus are treated as they appear in the Menu bar from left to right and per menu from the 
top to the bottom. Most commands in this section have already been described in other 
sections. You can find more detailed information for these commands through the links in the 
table.  

2.4.1 File menu 

You can use the File menu to open and save project files, and to exit MOLAND-LIGHT. The 
MOLAND-LIGHTsystem saves project files with a .geoproj extension attached to the file 
name. 

 
 

Option Function Link 
Create server 
project… 

Create a new server project file with 
MOLAND-LIGHT 

Section Creating a new 
project 

Open project… Open a project file stored on a disk Section Opening an existing 
project file 

Save project Save changes to the current project file Section Save a project file  
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Option Function Link 
Save project as… Save a project to a disk  Section Click the 

Save project 
command on the 
File menu. The 
Save project dialog 
window opens. 

 Enter a new 
integrated scenario 
name, e.g. Scenario 
1 in the text box 
next to Integrated 
scenario name. 

 Enter a description 
in the text box next 
to Integrated 
scenario 
description to 
reflect the changes 
you have made 
compared to the 
original baseline 
scenario. 

 Select Save as new 
scenario from the 
dropdown list next 
to Land use 
demand scenario.  

 Click the Details… 
button to open the 
Scenario details 
dialog window.  

 Enter a descriptive 
name, e.g. Land use 
Scenario 1 in the 
text box next to 
Name, and enter a 
short description in 
the text box next to 
Description  

 Click the Save 
button at the 
bottom of the Save 
simulation window 
to save the 
integrated scenario. 
You will see the 
name of your 
integrated scenario 
appear in the 
toolbar. 

Save a project file as 
Close project Close the project   
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Option Function Link 
Recent file list Display the names and the paths of the 4 

most recently opened project files. If you 
select one of the 4 files, it will be opened 

 

Exit Quit MOLAND-LIGHT  

2.4.2 Simulation menu 

You can use the Simulation menu to control a simulation. The commands Update, Run, Stop 
and Reset can also be invoked when pressing the respective buttons on the Toolbar. 

 
 

Option Function 
Update Recalculate variables that are affected by changes (except for the initial 

values and initial maps) via the user interface for the current simulation 
year. This command will not change the simulation time. 

Step Advance the simulation with one time step 
Run Advance the simulation till the next pause moment has been reached 
Stop Stop a simulation run 
Reset Recalculate variables that are affected by changes (including the initial 

values and initial maps) via the user interface for the start year of the 
simulation. Switch the simulation clock back to the start year of simulation. 

Pauses… Set the pauses of the simulation 

2.4.3 Maps menu 

You can use the Maps menu to select different maps and open their map windows. All kinds 
of maps available for the user are structured hierarchically by themes. There are essentially 
two types of maps: land use maps and indicator maps.  
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2.4.4 Options menu 

You can use the Options menu to personalise your workspace or to access the additional 
functionalities of MOLAND-LIGHT. 

 
 

Option Function 
Legend-files folder… Select the folder in which the legend files that MOLAND-LIGHT uses 

are located and stored. 
Write to Excel Establish or interrupt a link between MOLAND-LIGHT and the 

Microsoft Excel Workbook 
Log maps Store maps produced by the system in the form of .rst files 
Animation maps Store dynamic maps produced by the system in the form of .gif 

animations 

2.4.5 Window menu 

You can use the Window menu to arrange the contents of the screen and to activate one of the 
opened windows. 

 
 

Option Function 
Cascade Arrange multiple opened windows in an overlapped fashion 
Tile horizontal Arrange multiple opened windows one above another in a non-overlapped 

fashion 
Tile vertical Arrange multiple opened windows side by side in a non-overlapped 

fashion 
Arrange icons Arrange the icons for minimized windows at the bottom of the screen 
List of Windows Active the selected window on the list of opened windows 
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2.4.6 Help menu 

You can use the Help menu to select the type of help that you want MOLAND-LIGHT to 
display on the screen. The different commands in this menu permit you to look up 
information about MOLAND-LIGHT, its commands, options, and tools. 

 
 

Option Function Link 
Index Get the opening screen of the on-line help file of 

MOLAND-LIGHT 
Section Index 

Licence… Open the Licence window Section Licence 
About… Open the About window Section About 
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3. Model description 

This chapter describes each model building blocks (MBB) included in the system and builds 
on the documentation of the MOLAND land use model and Metronamica modelling 
framework, because MOLAND-LIGHT uses exactly the same underlying models as these two 
products. The variables used in each MBB are listed by the categories parameters, input, 
output, internal variables. Parameters refer to variables that are editable and can be 
configured by the user. Input refers to variables calculated by other MBB in the system. 
Output are those variables calculated by the respective MBB. They can be used as input for 
other MBB in the system and/or displayed as results and indicators in the user interface. 
Internal variables are only used internally in the respective MBB. 

3.1 MBB Land Use 

3.1.1 Description MBB Land use 

Objective  

The land use model allocates the (changes in) demand for land use on the land use map.  

User information  
Table 3-1 User information in the Land use model 

Drivers and Impacts Links to/from other MBB 

External influences Total demand for land use functions; 
 

Policy options -  
Other user options - 
Policy indicators Land use map. 

Environmental indicators 
Socio-economic indicators. 

Impacts MBB Spatial indicators: land use map; 

General information  
Table 3-2 General information in the Land use model 
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Type of information Description 
Type of model Constrained cellular automata, simulation. 
Application All cells. 
Spatial resolution Depending on the application case (from 50 to 1000 meter) 
Temporal resolution Year. 

Process description  

In MOLAND-LIGHT applications, the whole modelling area is represented as a mosaic of 
grid cells, each occupied with a specific land use. All cells together constitute the land use 
pattern of the study area.  

In principle, it is the relative attractiveness of a cell as viewed by a particular spatial agent, as 
well as the local constraints and opportunities that cause cells to change from one type of land 
use to another. Changes in land use at the local level are driven by four important factors (see 
Figure below): 

• Physical suitability, represented by one map per land use vacant and land use 
function modelled. The term suitability is used here to describe the degree to which a 
cell is fit to support a particular land use function and the associated economic or 
residential activity for a particular activity. Suitability maps are constructed based on 
physical characteristics of the location. Suitability maps remain constant during the 
simulation for land use vacants and land use functions unless new suitability maps for 
specific times are imported. The static suitability maps are described in the Suitability 
the section of this chapter. 

• Zoning or institutional suitability, represented by one map per land use function 
modelled. Zoning maps are used for enforcing spatial restrictions on the allocation of 
land uses. For each land use there is a time-series of zoning maps, specifying which 
cells can and cannot be taken in by the particular land use allowing changing zoning 
regulations over periods of time. The model allows for 3 time-periods, which can be 
changed by the user. Zoning maps remain constant during the simulation unless the 
user changes them. 

• Accessibility, represented by one map per land use function modelled. Accessibility 
is an expression of the ease with which an activity can fulfil its needs for 
transportation and other infrastructure in a particular cell based on the infrastructure 
network. The accessibility is calculated per land use function and only changes if the 
user changes the zonal accessibility parameters in the transport model or the 
infrastructure network or the accessibility coefficients (the importance of different 
land use functions to be close to different elements of the network) in the land use 
model. 

• Dynamic interaction of land uses in the area immediately surrounding a location is 
represented by the Neighbourhood potential. For each land use function, a set of 
spatial interaction rules determines the degree to which it is attracted to, or repelled 
by, the other functions present in its surroundings; a 196 cell neighbourhood. If the 
attractiveness is high enough, the function will try to occupy the location, if not, it 
will look for more attractive places. New activities and land uses invading a 
neighbourhood over time will thus change its attractiveness for activities already 
present and others searching for space. This process constitutes the highly non-linear 
character of this model. 

On the basis of these four elements, the model calculates for every simulation step the 
transition potential for each cell and function. In the course of time and until regional 
demands (provided by the user or calculated in the regional model) are satisfied, cells will 
change to the land use function for which they have the highest transition potential. 
Consequently, the transition potentials reflect the pressures exerted on the land and thus 
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constitute important information for those responsible for the design of sound spatial planning 
policies.  

Time LoopTime Loop1. Suitability

2. Zoning

Transition 
potential

Land use
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For land use function transitions take place based on a changing spatial demand from the 
different functions as well as internal dynamics in the region. The vacant land uses have a 
simplified dynamic calculation. For this function, there is no neighbourhood potential 
calculated, nor is zoning or accessibility taken into account. This causes that its dynamic is 
only based on the physical characteristics of the cell, the suitability. As stated above, features 
do not have their own dynamics. However, features do influence the allocation of land use 
functions in the model because they are can be an attraction or repulsion for certain land use 
functions and are as such included in the Neighbourhood potential.  

Note: Both suitability and zoning maps can be constructed with the OVERLAY-TOOL (part of 
the GEONAMICA toolbox) or with another GIS tool. If you like more information about the 
OVERLAY-TOOL, please contact RIKS.  

Assumptions  

• The model is developed on the assumption that all actors (land use functions) are in 
competition for space with one another. Actors are in search for interesting locations 
and can occupy those when they have the (financial) power to do so.  

Constraints 

• It is not possible to allocate more cells than there are available in the model area of 
the map. 

• Land use demands are determined exogenously. 

Equation, rules or algorithm 

The following figure explains the relations between the different components of the land use 
model and its relation to the other models incorporated in MOLAND-LIGHT. Elements in 
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black are included in the land use model; elements in grey represent other components of the 
MOLAND-LIGHT system. The arrows show the flows of information, black arrows represent 
current values and dashed arrows lagged values (values from the previous time step). 

 
The equations used in the land use model are described in the sub-sections of this section. 
Each of the elements in black –Neighbourhood potential, Accessibility, Suitability, Zoning, 
Transition potential and Land use– is described in a separate the section.  

Input  
Table 3-3 Input used in the Land use model 

Name Description Unit 
LUDf Demands for land use for each function f .  Number of cells  
tZAf,zc The zonal accessibility at time t for land use function f in transport 

zone z, zc the transport zone, in which cell c is located. 
- 

Parameters  
Table 3-4 Parameters used in the Land use model 

Name Description Unit 
LUini The initial land use map containing the land use that occupies each 

cell. 
- 

IN The network layers that consist of nodes and links of different 
types, representing the transport network. 

Line segment 

tZf,c The zoning maps for each land use function prepared in ArcGIS or 
OVERLAY TOOL. 

- 

S’f,c The suitability maps for each land use function and land use 
vacant prepared in ArcGIS or OVERLAY TOOL which have integer 
values from 0 to 10 

- 

MaxS Maximum suitability for all land uses which is used to rescale the 
integer values of input suitability maps to the range from [0,1] 

- 

ti 
The start of the first and second planning period for each zoning 
map. 

 

zaf 
Parameter controlling the steepness of the increase in the zoning 
for land use f from the last disallowed planning period to the first 
allowed planning period. 

 

( ),f fw d′  The spline that determines the influence of a land use f on another 
land use f’ for each distance in the neighbourhood. 

- 

α Stochastic noise parameter. - 
- True/false parameter per land use, specifying if the land use is 

contained in the set of urbanised land uses LUU or not. 
- 

Urbf The implicit accessibility for a land use on a built-up area. - 
NUrbf The implicit accessibility for a land use on a non-built-up area. - 

Suitability 

Zoning 

Neighbourhood 
potential 

Accessibility 

Total potential Land use 

Regional interaction or 
land use demand 
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Name Description Unit 
- True/false parameter per land use, specifying if the land use is 

impassable for other land uses or not. 
- 

ws,f The relative weight of the local accessibility for a certain link type 
and land use in the total local accessibility for that land use. 

- 

af,e Accessibility coefficient expressing the importance for land use f 
of having good access to certain elements e of the infrastructure 
network.  

- 

Output  
Table 3-5 Output given in the Land use model 

Name Description Unit 
tLU Land use of cellx,y. at time t. - 

References  

Engelen. G. White. R. Uljee. I. 1997. Integrating Constrained Cellular Automata Models, 
GIS and Decision Support Tools for Urban Planning and Policy Making. In: Decision 
Support Systems in Urban planning Edited by: H. Timmermans, Chapman & Hall, Part II.  

Engelen. G. White. R. Uljee. I. Drazan. P. 1995. Using Cellular Automata for Integrated 
Modelling of Socio-environmental Systems. Environmental monitoring and Assessment. 
30. 203-214.  

White. R. Engelen. G. Uljee. I. 1997. The Use of Constrained Cellular Automata for High-
Resolution Modelling of Urban Land Use Dynamics. Environment and Planning B, Part II. 
24. 323-343.  

White. R. Engelen. G. 1997. Cellular Automata as the Basis of Integrated Dynamic Regional 
Modelling. Environment and Planning B. 24. 235-246.  

White. R. Engelen. G. 1993. Cellular Automata and Fractal Urban Form: A Cellular 
Modelling Approach to the Evolution of Urban Land Use Patterns. Environment and 
Planning A. 25(8). 1175-1199.  

White. R. Engelen. G. 1993. Cellular Dynamics and GIS: Modelling Spatial Complexity. 
Geographical Systems. 1(2).  

3.1.2 Cellular Automata 

Cellular automata (CA) get their name from the fact that they consist of cells – like the cells 
on a checkerboard – and that cell states may evolve according to a simple transition rule, the 
automaton. A conventional cellular automaton consists of: 

• a Euclidean space divided into an array of identical cells. For geographical 
applications a 2 or 3-dimensional array is most practical; 

• a cell neighbourhood. For flow and diffusion processes the 4 (Von Neumann 
neighbourhood) or 8 (Moore neighbourhood) adjacent cells are sufficient, but for 
most socio-economic processes larger neighbourhoods are required; 

• a set of discrete cell states; 
• a set of transition rules, which determine the state of a cell as a function of the states 

of cells in the neighbourhood; 
• discrete time steps, with all cell states updated simultaneously. 

Until recently, Cellular Automata models raised only limited interest in the geographical 
community despite the fact that Tobler (1979) referred to them as “geographical models”. 
Originally, they were developed to provide a computationally efficient technique for 
investigating the general nature of dynamical systems. Recent applications, however, have 
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been directed at representing geographical systems more realistically, both in terms of the 
processes modelled and the geographical detail. These advances have been accompanied by 
an increase in the complexity of the models and in the effort to build more realistic models 
(Couclelis, 1997). A concise overview of the application of CA models in land use modelling 
and spatial planning can be found in Engelen, et al. (1999). 

Over the past years, we have developed a generic constrained cellular automata model and 
applied it to urban (White and Engelen, 1993, 1994, 1997; White, et al. 1997) and regional 
(Engelen, et al. 1993, 1995, 1996, 1997, 2000, 2002a) cases. This model is build up as 
follows. 

Notation 

In this chapter, we will consistently use the following notation: 

LU The set of all land uses. An element of this set – a land use – will be referred 
to by the letter f. 

t Time index of a variable. All dynamic variables have a time index that is 
written in superscript to the left of the variable, for example tZ . 

c A cell on the grid (map). Sets or variables that are defined for each cell on the 
map are preceded by a set of brackets within which the specific cell is 
indicated – for example ( )f c  is the land use function occupying cell c. 

Other notations will be introduced when appropriate. 

The cell space 

The cell space consists of a 2-dimensional rectangular grid of square cells each representing 
an area ranging from 50 m × 50 m to 1000 m × 1000 m. The grid size and shape varies 
according to the requirements of the application, but is typically less than 1000 by 1000 cells. 
The grid may be larger, but at the cost of longer run times. The same applies to the resolution 
of the model: it is technically possible to increase the resolution of the CA model, but this 
requires working on larger neighbourhoods (in terms of cellular units) as well, which 
increases the execution time considerably. Moreover, before increasing the resolution of the 
CA model, it is essential to analyse whether this would lead to any better results. It would be 
wrong to decrease the size of the cells beyond the typical physical entities, the blocks or plots 
that are the subject of the location decisions of the spatial agents determining the use of the 
land. Very often also, the basic map material will not be available or it will become unreliable 
at high resolutions and the processes modelled are laden with uncertainty. Thus, a higher 
spatial resolution might give a false impression of detail and information, but could result is 
less realistic spatial dynamics. 

The neighbourhood 

The cell neighbourhood is defined as the circular region around the cell out to a radius of 
eight cells. The neighbourhood thus contains 196 cells – see figure 3-1 – arranged in 30 
discrete distance zones forming concentric circles. We indicate the collection of cells that 
form the neighbourhood of a cell c by ( )D c . The distance between cells a and b, ( ),d a b , is 

given by 2 2X Y+ , where X and Y represent the horizontal and vertical distance between 
the cells, respectively. The distances between the cells in each concentric circle and the centre 
cell in figure 3-1 are listed in table 3-6. 

Table 3-6 Distances and distance-numbers in the cell neighbourhood. 
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Concentric circle 1 2 3 4 5 6 7 8 9 10 
Distance (in cells) 0 1 1.41 2 2.24 2.83 3 3.16 3.61 4 
Concentric circle 11 12 13 14 15 16 17 18 19 20 
Distance (in cells) 4.12 4.24 4.47 5 5.10 5.39 5.66 5.83 6 6.08 
Concentric circle 21 22 23 24 25 26 27 28 29 30 
Distance (in cells) 6.32 6.40 6.71 7 7.07 7.21 7.28 7.62 7.81 8 

 
Figure 3-1 All cells in the neighbourhood are in exactly one concentric circle. The index of 

the circle depends on the distance of the circle’s cells to the centre of the 
neighbourhood (circle 1). 

Depending on the resolution of the grid, the neighbourhood radius represents distances 
ranging from 0.4 km to 8 km – for grid resolutions ranging from 50 m to 1000 m, respectively. 
This distance delimits an area that is similar to what residents and entrepreneurs commonly 
perceive to be their neighbourhood. It should thus be sufficient to allow local-scale spatial 
processes to be captured by the CA transition rules. 

The cell states 

The cell states represent typically the dominant land use in each cell. A distinction is made 
between dynamic elements, called land use functions and static elements, called land use 
features. Land use features will not change as the result of local-scale dynamics. They do not 
change location, but influence the dynamics of the land use functions and thus affect the 
general allocation process. For example, a land use function ‘Beach tourism’ will be strongly 
influenced by the presence (or absence) of the land use feature ‘Beach’. Clearly, raising the 
number of states in the CA will increase – in theory at the least – the number of possible state 
transitions of each cell and defining the transition rules of the model will become more 
cumbersome. Again, it requires special attention on behalf of the model developer to keep this 
complexity within limits. It is useful to distinguish between land uses if and only if these land 
uses behave differently in space. If, however, their spatial dynamic is very similar, then land 
uses can just as well be combined into a single land use function. 

The neighbourhood effect 

The fundamental idea of a CA is that the state of a cell at any time depends on the states of 
the cells within its neighbourhood. Thus, a neighbourhood effect must be calculated for each 
of the land use function states to which the cell could be converted. In our models, the 
neighbourhood effect represents the attraction (positive) and repulsion (negative) effects of 
the various land uses and land covers within the neighbourhood – see figure 3-2. 
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Figure 3-2 For the calculation of the neighbourhood effect, a circular neighbourhood 

consisting of 196 cells is applied (left). For each land use function, the transition 
rule is a weighted sum of distance functions calculated relative to all other land 
use functions and features (right). 

In general, cells that are more distant in the neighbourhood will have a smaller effect. Thus 
each cell in a neighbourhood will receive a weight according to its state and its distance from 
the central cell. Specifically, the neighbourhood effect is calculated as 
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f cR  The neighbourhood effect in cell c for land use f at time t. 
( )t f c  The land use occupied by cell c at time t. 
( ),d a b  The Euclidian distance between cell a and cell b – see table 3-6. 

( ),f fw d′  The influence function, expressing the strength of the influence of a cell with 
land use f’ on land use f for each distance d in the CA neighbourhood. 

An example of an influence function for the influence of one land use on another land use is 
shown in figure 3-3. At every distance in the CA neighbourhood, the influence function has a 
value that can be changed. Hence, in total, the influence function is determined by 30 points. 
This has the advantage of enabling the definition of very complex functions. However, its 
disadvantage is the large number of parameters that needs to be defined and calibrated, which 
troubles the automatic calibration routine greatly. To overcome this difficulty (largely), the 
influence functions are transformed to splines defined by only four points. For these splines, 
the following properties should hold: 

• The inertia value is always given on the vertical axis, that is, at distance 0. Thus, the 
first point is (0, inertia). 

• The second point must be located at distance 1. This point is indicated by (1, a). 
• The last point of the spline (at distance d) should have value 0, such that for all 

distances larger than d, the function value is 0. This point is indicated by (d, 0). 
• There is one point (b, c) that can be anywhere between the second and the last point. 

Hence, 1 < b < d. 

An example of a four-point spline is shown in figure 3-3. The vertical lines represent the 
distances on the 30 concentric circles. Previously, the influence functions were defined with a 
point on each of these lines. In the four-point spline, there are still values for each concentric 
circle, but they are linearly interpolated, instead of user-defined. 
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Figure 3-3 An example of an influence function 

The transition rules 

The goal of the CA model is to allocate a cell state to each cell on the map, in order to 
simulate the dynamic behaviour of land use functions. The allocation is performed on the 
basis of a to be specified algorithm that works on a vector of values – one value for each cell 
state – for each cell, known as the transition potentials. These transition potentials are 
determined on the basis of the neighbourhood effect, but can take other factors into 
consideration as well, such as the physical or institutional suitability of the location, the 
availability of transport connections or even a stochastic factor to take into consideration the 
possible effects of unpredictable occurrences. Together these transition potentials and the 
allocation algorithm make up the transition rules of the CA model. 

In the simplest of cases, the transition potential can be taken as the neighbourhood effect and 
the allocation algorithm allocates the cell state with the highest potential to each cell that is 
occupied by a land use function – as indicated before, land use features are not modelled by 
the CA model, but are taken as static elements. In a more complex model, the factors 
mentioned above are incorporated into the transition potentials and the allocation algorithm 
takes into account the number of cells that need to be allocated to each cell state, which is 
exogenous to the CA model. 

3.1.3 Neighbourhood potential 

Purpose and use 

This block calculates the neighbourhood effect as described in the previous section (Cellular 
Automata). The neighbourhood effect is used to calculate the Transition potential values. 
Clicking this model block will open the influence table dialog window that displays the 
influence function of each land use on each vacant or function land use. 

Process description 

Each land use that occurs in a cell has an effect on the possible future occurrence of each land 
use function in all cells within the neighbourhood that is dependent on the distance between 
the two cells. The influence functions describe the effect of one land use on another at each 
distance in the neighbourhood. These influences are accumulated to produce the 
neighbourhood effect in each cell for each land use function. 

(0, inertia) 

(1, a) 

(b, c) 

(d, 0) 
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Algorithm 

The neighbourhood effect in cell c for land use f( ,
t

f cR ) is calculated based on the land use 

occupied by cell c ( ( )t f c ), the influence function ( ( ),f fw d′ ), expressing the strength of the 
influence of a cell with land use f’ on land use f for each distance d in the CA neighbourhood,  
the neighbourhood of cell c ( ( )D c ) and the Euclidian distance between cell a and cell b 

( ( ),d a b ): 

 
( ) ( )( )

( )
, ,

,t
t

f c f f c
c D c

R w d c c
′

′∈

′= ∑
  

Parameters, input and output 
Table 3-7 Neighbourhood input 

Name Description 
tf(c) The map that contains the land use that occupies each cell at time t. 

Table 3-8 Neighbourhood parameters 

Name Description 

( ),f fw d′  
The spline that determines the influence of a land use on another land use for each 
distance in the neighbourhood. 

Table 3-9 Neighbourhood output 

Name Description 
tRf,c A map for each land use function containing the neighbourhood effect for that land use 

for each cell. 

3.1.4 Accessibility 

Purpose and use 

Accessibility measures the effect of the nearness and importance of different types of 
transport networks – such as local roads, highways or railroads – on the possible future 
occurrence of each land use function on a certain location. The accessibility is used to 
calculate the Transition potential values.  

Process description 

The accessibility for each land use function is a composite measure of four types of 
accessibility: zonal accessibility, local accessibility, implicit accessibility and explicit 
accessibility. 

Zonal accessibility 

The zonal accessibility is a measure based upon the generalised cost from a transport zone to 
origins and destinations. It is calculated in the transport model. The transport zones are 
specified in an additional region map. 

Local accessibility 

The local accessibility reflects the extent to which the need for the presence or absence of the 
transportation network of a land use can be fulfilled. The network consists of a number of 
network layers that are made up of nodes – such as stations – and links – such as roads. The 
local accessibility is first determined for each node or link type separately and, thereafter, 
combined into one value for each land use and each cell. 
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For each land use, the local accessibility for a certain link type can be either decreasing or 
increasing over distance, indicated by a positive or negative value for the distance decay 
parameter, respectively. A positive value indicates that the land use needs to be located close 
to that link type, whereas a negative value indicates that the land use needs to be located away 
from the link type. The functional form of this effect is hyperbolic with respect to the distance, 
where the distance decay parameter determines the rate of the increase or decrease – see 
figure 3-4. Note that the local accessibility per link type lies in the range (0, 1). 

 

 
Figure 3-4 Effect of proximity to the network as a function of the distance for 

a value of 1 and -1, respectively, for the distance decay parameter. 
An increase in the absolute value of the parameter will multiply the graph with 
respect to the vertical axis. 

When there is a positive value for the distance decay parameter for a particular land use and 
link type, the land use prefers to be located close to that link type. When there is a negative 
value, the land use prefers to be located away from that link type. To combine all the local 
accessibilities per link type, we need to make a distinction between these positive and 
negative effects, since they comprise a different concept and should be combined differently. 

For negative effects, the local accessibility per link type can be interpreted as the extent to 
which the land use remains unhindered by the presence of the transport network. If a land use 
is not hindered by the presence of one link type, it can still be hindered by the presence of 
another link type. Hence, the total negative local accessibility is determined by the product of 
the local accessibilities per link type with negative distance decay, where the link types are 
given a weight expressing their relative importance. The total negative local accessibility can 
then be treated the same as a positive effect. 

For positive effects, the local accessibility per link type can be interpreted as the extent to 
which the need of a land use for the presence of the transport network can be fulfilled by that 
link type. If this need cannot be totally fulfilled by one link type then the remaining part can 
be fulfilled by another link type and so on. Hence, the (total) local accessibility can be 
interpreted as the extent to which the need for presence of the transport network of a land use 
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can be fulfilled by any of the link types, where the link types are given a weight expressing 
their relative importance. 

Note that the order in which we examine the link types in this approach is irrelevant. This 
becomes clear if we turn things around. The extent to which the need for presence of the 
transport network can be fulfilled by any of the link types is the same as the complement of 
the extent to which this need cannot be fulfilled by any of the link types. Again, ‘cannot be 
fulfilled’ is the complement of ‘can be fulfilled’. Hence, we are looking for the complement 
of the intersection of the complements of the extent to which this need can be fulfilled by 
each link type. In set theory, thisorem is known as DeMorgan’s law (Casella & Berger, 1990). 

Implicit accessibility 

The implicit accessibility reflects the fact that when an area is occupied by an urban land use, 
measures will be taken to assure its accessibility. This is the case even if it does not appear so 
on the network map. For the land use model, this is especially significant, because, as the 
cellular automata model changes the land use map, it does not change the network map 
accordingly. 

The implied accessibility takes one of two possible values for each land use class; one for 
urbanised areas and one for non-urbanised areas. A cell is urbanised if its current land use 
class is flagged as a ‘built-up area’. These flags are, therefore, parameters of the accessibility 
model block. 

Explicit accessibility 

When determining the distance from a certain location to the nearest link of a certain type, we 
should take into account that areas occupied by some specific land uses – such as lakes – 
cannot be crossed. Hence, this distance cannot be measured in a straight line. To achieve this 
effect in our distance determining algorithm, we say that a segment of the network is not 
reachable from a cell occupied by an impassable land use. 

However, while some land uses are impassable for activity generated by other land uses, they 
are passable for activity generated by its own land use – think, for example, of a military land 
use. Therefore, when a land use is impassable, the explicit accessibility for the same land use 
is equal to the implicit accessibility, while the explicit accessibility for other land uses is 0. 

Total accessibility 

These four types of accessibility are combined in a single value in the range (0, 1) for each 
land use and each cell, expressing the effect that the transportation network has on the 
possible future occurrence of that land use in that cell. If the cell is currently occupied by an 
impassable land use, the total accessibility is equal to the explicit accessibility. Otherwise, the 
total accessibility equals the product of the zonal accessibility, the local accessibility and the 
implicit accessibility. 

Algorithm 

The local accessibility of cell c to link type s for land use f ( , ,
t

s f cLA ) is calculated: 
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In this equation ,
t

s cD is the distance (in cells) between cell c and the nearest cell that is 

covered by a link type s at time t and ,s fa  the accessibility distance decay parameter, 
expressing the importance of good access to an infrastructure element of type s for land use f. 
A positive value indicates that land use f is positively influenced by the nearness of 
infrastructure of type s and a negative value indicates a negative influence 

The local accessibility of all link types with negative distance decays is defined: 

 , , , ,
f

t neg t
f c s f s f c

s S

LA w LA
−∈

= ⋅∏   

 ,
f

neg
f s f

s S

w w
−∈

= ∏   

In these equation is ,
t neg

f cLA  the total negative local accessibility of cell c for land use f at time 

t, fS −  the set of all link types that have a negative distance decay parameter for land use f, 

,s fw  the relative weight of the proximity to the different networks on the total local 

accessibility -the values of these parameters lie in the range (0, 1)-, , ,
t

s f cLA  the local 

accessibility of cell c to link type s for land use f , neg
fw  the total weight of the local 

accessibilities with a negative distance decay parameter. 

The total local accessibility of cell c for land use f ( ,
t

f cLA ) is calculated: 
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In this equation is ,
t neg

f cLA  the total negative local accessibility of cell c for land use f , neg
fw  

the total weight of the local accessibilities with a negative distance decay parameter, fS +  the 

set of all link types that have a positive distance decay parameter for land use f, ,s fw the 
relative weight of the proximity to the different networks on the total local accessibility -the 
values of these parameters lie in the range (0, 1), , ,

t
s f cLA the local accessibility of cell c to 

link type s for land use f. 

The implicit accessibility ( ,
t

f cIA ) is calculated: 

 
( )

,

if 

otherwise
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f c
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In this equation is fUrb  the implicit accessibility for land use f of a cell that is occupied by an 

urban land use, fNUrb  the implicit accessibility for land use f of a cell that is occupied by a 

non-urban land use, ( )t f c  the land use occupied by cell c, ULU  the set of urbanised (built-
up) land uses. 

The explicit accessibility ( ,
t

f cEA ) is calculated: 
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( ),
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if 

0 otherwise
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In this equation ( ,
t

f cIA ) is the implicit accessibility of cell c for land use f and ( ( )t f c ) the 
land use occupied by cell c. 

The total accessibility ( ,
t

f cA ) is defined as: 

 
( ),

,
, , ,

if 

otherwise
c

t t
f c It

f c t t t
f z f c f c

EA f c LU
A

ZA LA IA

⎧ ∈⎪= ⎨
⋅ ⋅⎪⎩

  

In this equation is ( ,
t

f cEA ) the explicit accessibility of cell c for land use f , ( )t f c  the land 

use occupied by cell c, ILU  the set of impassable land uses, ,
t

f zZA the zonal accessibility for 

land use function f in transport zone z, cz  the transport zone, in which cell c is located, 

,
t

f cLA the local accessibility of cell c for land use f and ,
t

f cIA  the implicit accessibility of cell 
c for land use f . 

Parameters, input and output 
Table 3-10 Accessibility input 

Name Description 
- The network layers that consist of nodes and links of different types, representing the transport 

network. 
tZAf,zc The zonal accessibility at time for land use function f in transport zone z, zc the transport zone, 

in which cell c is located. 

Table 3-11 Accessibility parameters 

Name Description 
- True/false parameter per land use, specifying if the land use is contained in the set of urbanised 

land uses LUU or not. 
Urbf The implicit accessibility for a land use on a built-up area. 
NUrbf The implicit accessibility for a land use on a non-built-up area. 
- True/false parameter per land use, specifying if the land use is impassable for other land uses or 

not. 
ws,f The relative weight of the local accessibility for a certain link type and land use in the total local 

accessibility for that land use. 
as,f The rate at which the local accessibility for a certain link type and land use decreases – for 

positive values – or increases – for negative values – over distance. 

Table 3-12 Accessibility output 

Name Description 
tAf,c The map that contains the accessibility value for each cell. 

3.1.5 Suitability 

Purpose and use 

Suitability quantifies the effect that physical elements of the land have on the possible future 
occurrence of land uses on a certain location. 
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Process description 

Suitability is a complicated measure on the basis of ecological, physical, technical or 
economical factors that determine the physical appropriateness of a cell to receive the land 
use. Suitability is expressed as a value between 0 (not suitable) and 1 (perfectly suitable). The 
suitability maps are exogenous to the model and can be created with the help of the 
OVERLAY-TOOL. They can also be edited in the full MOLAND system. 

Algorithm 

Not applicable. 

Parameters, input and output 
Table 3-13 Suitability parameters 

Name Description 
S’f,c The suitability maps for each land use (except for agriculture) function and land use vacant 

prepared in ArcGIS or OVERLAY TOOL which have integer values from 0 to 10 or 100 

Table 3-14 Suitability output 

Name Description 
Sf,c A value for each vacant or function land use containing the suitability of each cell for that 

land use which have values from 0 to 1 

3.1.6 Zoning 

Purpose and use 

Zoning quantifies the effect that planning and legislation has on the possible future 
occurrence of each land use function on a certain location. 

Process description 

The zoning maps specify for each cell and for each land use the moment from which the 
specific land use is allowed in that cell. One of four moments can be chosen: the start year of 
the simulation, the first planning period, and the second planning period and never. The start 
of the first and second planning period can be specified per zoning map – hence, per land use. 

If a land use is allowed in a cell, the zoning for that land use and cell is 1. If it is not allowed 
and also not allowed from the next planning period onwards, the zoning will equal 0. If it is 
not allowed right now, but it is allowed from the next planning period onwards, then the value 
of the zoning will be equal to the fraction of the time from the current planning period to the 
next that has passed, raised to the power of the inverse of the zoning anticipation parameter. 
Hence, with the zoning anticipation parameter equal to 1, the zoning will linearly increase 
from 0 at the start of the last planning period where the land use is not allowed to 1 at the start 
of the first planning period from which onwards the land use is allowed. A higher value for 
the zoning anticipation parameter will yield a steeper rise of the zoning at the beginning of 
this phase. 



 

 58

 
Figure 3-5 Increase of zoning from the start of the last disallowed planning period (0) to the 

start of the first allowed planning period (1) with a value of 0.5 for the zoning 
anticipation parameter. 

Algorithm 

The zoning for land use f in cell c ( ,
t

f cZ ) is calculated: 
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In this equation is ( ),p f c  the planning period from which onwards land use f will be 

allowed in cell c, it  the start of planning period i and fza the zoning anticipation parameter 
for land use f. 

Parameters, input and output 
Table 3-15 Zoning parameters 

Name Description 
ti The start of the first and second planning period for each zoning map. 
zaf Parameter controlling the steepness of the increase in the zoning for land use f from the last 

disallowed planning period to the first allowed planning period. 

Table 3-16 Zoning output 

Name Description 
tZf,c A numerical map for each function land use specifying whether that land use is allowed in 

each cell (1) or not (0). 

3.1.7 Transition potential 

Purpose and use 

The transition potentials form the basis, on which the allocation algorithm is to determine 
which land use will occur in each cell after a time step has been made. They can be 
interpreted as the utility level that a location ascribes to a particular land use being present and, 
vice versa, which a land use ascribes to being located on that location.  
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Process description 

The transition potential combines the effect of the neighbourhood, accessibility, suitability 
and zoning on the possible future occurrence of each land use on a particular location. 
Moreover, the neighbourhood effect is given a stochastic perturbation to simulate the effect of 
unpredictable occurrences. The extent of this perturbation can be controlled with the α-
parameter. 

The values for suitability and zoning are weighed and summed to give the combined effect of 
physical and institutional suitability on the land use. This is then multiplied with the 
accessibility to provide a measurement of the heterogeneity of the modelled area. If the value 
of the neighbourhood effect is positive, we multiply it with this measure to yield the transition 
potential. If it is negative, we subtract this measure from its maximum value and multiply the 
result of that with the neighbourhood effect to yield the transition potential, since the 
transition potential should decrease with a decrease in the measure of heterogeneity. 

Algorithm 

The transition potential for land use function f in cell c ( ,
t

f cP ) is calculated using the 
following equations: 
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The transition potential is a multiplication of the neighbourhood potential ( ,
t

f cR ), the 

suitability ( ,f cS ), the zoning ( ,
t

f cZ ) and the accessibility ( ,
t

f cA ). If a stochastic perturbation 
is included, two extra factors have to be taken into account: a random value drawn from a 

( )1Weibull ,1α  distribution (e) and a parameter that controls the extent of the random effect 

in the potential (α). The value of this last parameter must be in the range [ ]0,1 . 

For vacant states the transition potential is simplified to: 

 , ,
t t

f c f cP S=   

Parameters, input and output 
Table 3-17 Transition potentials input 

Name Description 
tRf,c The neighbourhood effect for each land use and each cell. 
tSf,c The suitability for each land use and each cell. 
tZf,c The zoning for each land use and each cell. 
tAf,c The accessibility for each land use and each cell. 

Table 3-18 Transition potentials parameters 

Name Description 
α Parameter controlling the extend of the stochastic perturbation performed on the neighbourhood 

effect. A value of 0 means no perturbation. 

Table 3-19 Transition potentials output 
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Name Description 
tPf,c The transition potential for each land use and each cell. 

3.1.8 Land use 

Purpose and use 

The land use model block holds the land use map, which it updates every time step by means 
of the allocation algorithm of the CA model. Clicking the land use block in the system 
diagram will open a dialog window from which the land use map can be opened. 

Process description 

The land use map is updated with the aid of the transition potential maps for each vacant and 
function land use – land use features are not modelled, but taken as static entities – in 
accordance with the number of cells that has to be allocated to each land use function in each 
region. Note that vacant land uses need not be allocated to a specific number of cells, but will 
be allocated after the required number of cells has been allocated to all land use functions. 

This procedure can be understood most easily by considering the land use functions as agents 
that need to occupy a certain number of cells in each region, such that the accumulated 
transition potential in those cells is maximal, and considering the cells in each region as 
agents that want to be occupied by a land use that has the highest transition potential in that 
cell. In this light, the allocation procedure yields an equilibrium outcome, in which no land 
use can find a cell that it can occupy – meaning the currently allocated land use has a lower 
transition potential value in that cell –, while vacating another cell and, thereby, increase its 
accumulated transition potential. At the same time, no cell can find a land use that is willing 
to vacate another cell and occupy this cell – thus increasing its accumulated transition 
potential –, thereby increasing the transition potential in this cell. 

The equilibrium state is found by an iterative procedure, in which the land use function that 
has the highest transition potential in an unallocated cell in the region is allocated to that cell, 
as long as more cells need to be allocated to that land use. Thereafter, the vacant land use with 
the highest transition potential is allocated to each unallocated cell. 

It is easy to verify that this procedure yields an outcome that satisfies the conditions of the 
equilibrium state. Moreover, if we assume that all transition potential values are unique, the 
equilibrium state is unique as well. 
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Algorithm 

for each region 
allocate the current land use to all cells occupied by a land use feature 
while some cells have to be allocated to some land use function 

select the land use function for which we still need to allocate more cells that
has the highest total potential value in an unallocated cell  
allocate the land use to that cell 

end while 
while not all cells have been allocated a land use 

select the vacant land use with the highest potential in an unallocated cell 
allocate the land use to that cell 

end while 
end for  

Parameters, input and output 
Table 3-20 Land use parameters 

Name Description 
LUini The land use map at the start of the simulation. 

Table 3-21 Land use input 

Name Description 
tPf,c The transition potential for each land use and each cell c. 
tNf,i The number of cells that need to be allocated to each land use function f in each region i. 

Table 3-22 Land use output 

Name Description 
tf(c) The land use that currently occupies each cell in the map at time t. 

3.2 MBB Spatial indicators 

3.2.1 Description MBB Spatial indicators 

Objective 

The MOLAND-LIGHTsystem develops comparable databases to derive indicators in order to 
understand the evolution of urban areas and impacts on the surrounding environment. At the 
basis of its approach lies the idea that without a spatial approach, any urban indicator set 
aiming to address sustainability would be incomplete. 

The spatial indicators model calculates the spatial indicators dynamically with the changing 
land use on a yearly basis and are available in the form of dynamic maps and numeric outputs.  

User information 
Table 3-23 User information in the spatial indicators model 

Drivers and Impacts Links to/from other MBB 
External influences MBB Land Use: land use map 
Policy options - 
Other user options Parameter sets for each spatial indicator. 
Policy indicators Environmental indicators, Social-economic indicators 
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Drivers and Impacts Links to/from other MBB 
Impacts - 

General information 
Table 3-24 General information in the spatial indicators model 

Type of information Description 
Type of model Various indicator models 
Application All cells within the modelling area 
Spatial resolution Depending on the application case 
Temporal resolution Year 

Process description 

An indicator in this context is a measure to make a particular phenomenon perceptible that is 
not – or at the least not immediately – detectable. On the other hand, indicators can also be set 
up to verify legislative guidelines or policy goals. Indicators are in fact small model blocks 
that generally simplify in order to make complex phenomena quantifiable in such a manner 
that communication is either enabled or promoted. 

Clearly, with the system like MOLAND-LIGHT, which generates evolving land use patterns 
and the associated high resolution land use/land cover maps, the generation of spatially 
referenced indicators in a dynamic manner becomes a distinct possibility. 

The calculation of indicators can be done as part of a post-processing task on the spatial 
output written to file and stored during a simulation. The MAP COMPARISON KIT and the 
OVERLAY-TOOL are appropriate instruments to produce indicators based on land use changes, 
respectively composite indicators based on the combination and weighing of land use and 
ancillary maps. Alternatively, it is possible to incorporate the calculation of spatial indicators 
in the system and have them calculated dynamically with the changing land use. Like the 
other variables, indicators are thus calculated on a yearly basis and are available in the model 
in the form of dynamic maps, time charts and numeric outputs. 

The functionality available in the spatial indicator models has the following characteristics. 

• A set of indicator algorithms has been incorporated to visualise and assess the effects 
of urban spatial patterns and the possible effects of this in social, economic and 
environmental terms, but also on floods, forest fires, landslides and other natural 
hazards. The open architecture of GEONAMICA enables the straightforward 
incorporation of additional indicator algorithms at a later stage. 

• The algorithms that have been implemented perform mathematical operations on the 
land use map and the output of the regional interaction model generated in the course 
of a simulation and on external data that can be entered interactively. 

• The algorithms can be configured interactively (via the user interface) by the end-user 
of the model on the basis of a number of parameters. In fact, an indicator consists of a 
generic algorithm, determining the type of indicator, and its set of parameter values, 
determining the interpretation of the indicator. Within a model, a single algorithm can 
be employed with different parameter values as often as desired. 

• In a model run, the user can switch an indicator on or off. All indicators that are 
switched on are updated after every time step. They are presented in a dialogue 
window and an associated map window that the user can open and close during the 
run. Like for all other maps in the model, statistical information relative to the 
information displayed on the map is available by clicking the mouse in the map – see 
the User Manual. Indicator maps can be exported in IDRISI format. In addition to the 
map, for every indicator a synthetic value is calculated over all cells of the map, a 
sum, weighted sum or average of all cells (depending on the algorithm). This value is 
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represented as an index value in a time chart that is also accessible via the dialogue 
window. 

• Finally, the indicator maps can be written to a log file or animated GIF file. The log 
files can be opened by means of the MAP COMPARISON KIT enabling the analysis of 
changes in the indicator maps generated within a single run or in different runs of the 
model. The animations are automatically stored on the hard disk and available after 
the simulation as animated GIF files that can be opened and viewed with any 
graphical viewer or internet browser program. 

The MOLAND-LIGHT system includes the pre-defined spatial indicators. From the above, it 
will be clear that the user can also define a set of new indicators based on the algorithms 
currently available in the models or he can extend or modify a list of existing indicators. This 
is possible in the full MOLAND system by means of the Spatial indicators dialogue window 
(see the section MBB Spatial indicators) 

Assumptions 

Some indicator algorithms use a search radius or target cluster radius defined in terms of a 
number of cells. This means that the indicator will work within a neighbourhood of the cell 
being analysed that has a radius equal to the value of this parameter. The neighbourhood is 
defined analogous to that of the neighbourhood effect in the land use model. Hence, the 
resulting area is circular only by approximation as depicted in figure 3-6. 

 

 
Figure 3-6 Areas belonging to search radii of 0, 1, 1.42, 2, 2.24, 2.83, and 3, respectively 

Constraints 

• Some indicators require an additional map (ancillary map) to be specified as one of 
the parameters.  

Equation, rules or algorithm 

As indicators are model blocks, the outline of each sub-section will follow that of other model 
blocks. The equations used in the spatial indicator models are described in the sub-sections of 
this section which give a description of the different indicator algorithms that are currently 
available in the system. The contents will, however, be more general, since we are describing 
categories of indicators and not actual indicators, which are comprised of the category of 
indicator and a set of parameter values for that category of indicator. 

Parameters 
Table 3-25 Parameters used in the spatial indicators model 

Name Description 
Search radius 
(cells) for cluster 
indicator 

The minimum size of a cluster. This can range from 0 to 25. The default value is 0. 

Road is obstacle Determines whether a road can intersect a cluster (checked) or not (unchecked). By 
default this is unchecked. 

Target for 
cluster indicator 

Specifies whether a land use contributes to the cluster size (checked) or not 
(unchecked). By default this is unchecked. 
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Name Description 
Search radius 
(cells) for 
neighbourhood 
indicator 

The radius in cells within which the algorithm looks for a land use that will be 
added to the numerator, denominator, or both. By default the minimum value for 
this parameter is 1 and the maximum is 25. A value of 1 will only count the current 
cell. The default value for this parameter is 10. 

Numerator The weight with which the corresponding land use will be added to the numerator. 
These values can range from 0 to 1000 and are set to 0 by default. 

Denominator The weight with which the corresponding land use will be added to the 
denominator. These values can range from 0 to 1000 and are set to 0 by default. 

Target cluster 
radius for 
distance 
indicator 

This is the minimum size that a cluster of target cells should have to be considered a 
target. This value can range from 1 to 25 and is set to 10 by default. 

Role of land use Per land use you can specify whether it is a source, a target or neither (n.a.). 
Range for 
counting cells 
for distance to 
map indicator 

Only count cells with the specific value for distance to map indicator. 

Source for 
distance to map 
indicator 

Sets for each land use whether the distance to the target areas should be shown or 
not. By default, all sources are unchecked. 

Area file for 
distance to map 
indicator 

Specifies the path and filename of a binary map file specifying the areas to which 
the distance should be calculated. Unless a proper file is specified, the indicator 
cannot be calculated. 

Disturbance 
value 

The value of the disturbance can range from 0 to 25 and is set to 0 by default. 

Range for 
counting cells 
for 
mask/mapping 
indicator 

Only count cells with the specific value for mask/mapping indicator. 

Search radius for 
habitat 
fragmentation 
indicator 

The search radius around the centre cell. The unit of the search radius depends on 
the cell size. 

Power z This comes forth from the empirical relation zN c A= ⋅ , where N is the number of 
species, c is a constant and A is the surface. 

Resistance of 
road 

The resistance of a road. If a road crosses through a cell, the resistance of that cell is 
taken as the maximum of the resistance of that land use and this value. 

Fraction Signals per land use whether it belongs to the habitat (1) or not (0). 
Resistance The resistance of the corresponding land use. 
Land use change 
classification 

The value that will be displayed in the result map if the cell has land use from in the 
base map and to in the current land use map. A value of -1 will result in a ‘no data’ 
value. 

Metric The measure of spatial patterns to use. 

Input 
Table 3-26 Input used in the spatial indicators model 

Name Description 
Initial land use map The land use map for the start year of the simulation. 
Land use map The current land use map 
Basis map Depending on the algorithm: e.g. storm intensity map, flood intensity map, low 

land map, steep slope map etc. 

Output 
Table 3-27 Output given in the spatial indicators model 
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Name Description 
Dynamic maps Depending on the algorithm 
Numeric values Depending on the algorithm 
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3.2.2 Cluster indicator 

Purpose and use 

This type of indicator can be used to pinpoint clusters consisting of a certain land use or a 
certain group of land uses. 

Process description 

All cells that are occupied by a land use that has target value 0 will be ignored in the 
algorithm, as will all cells outside the modelling area. In the remaining cells, we then identify 
clusters of cells and calculate their size. 

To identify all clusters, we mark all centre cells – that is, cells that are not ignored and for 
which all cells within the search radius are also not ignored – and all cells that are within the 
search radius of a centre cell. We then define a cluster to be a group of horizontally or 
vertically adjacent cells that are not ignored, where each cluster must contain at least one 
marked cell. The value of each cell in a cluster is equal to the size of the cluster, which is 
defined as the sum of the target value of the current land use of each cell in the cluster. The 
value of all other cells is set to ‘no data’. 
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Algorithm 

clear all marks from all cells 
for each cell c in the model area 

if the current land use in cell c is checked and cell c does not contain a link type 
that is an obstacle 

assign mark I to cell c 
end if 

end for 
for each cell c that has mark I or mark II 

if all cells in the neighbourhood of cell c have mark I or mark II 
assign mark II to cell c and all cells in the neighbourhood of cell c 

end if 
end for 
for each cell c that has mark II 

remove all marks from cell c 
{ }L c= , M =∅  

size = 0 
while L ≠ ∅  

remove the cell d that is first in the list L from L and add it to list M 
increment size with area of cell d 
for each cell e that is horizontally or vertically adjacent to cell d 

if cell e has mark I or mark II 
remove all marks from cell e 
add cell e to the end of list L 

end if 
end for 

end while 
assign the value size to each cell in the list M 

end for  

Parameters, input and output 
Table 3-28 Cluster indicator parameters 

Name Description 
Search radius (cells) The minimum size of a cluster. This can range from 0 to 25. The default value 

is 0. 
Road is obstacle Determines whether a road can intersect a cluster (checked) or not (unchecked). 

By default this is unchecked. 
Target Specifies whether a land use contributes to the cluster size (checked) or not 

(unchecked). By default this is unchecked. 

3.2.3 Neighbourhood indicator 

Purpose and use 

This type of indicator can be used to calculate figures consisting of the ratio of sums of 
weights associated with land uses in the vicinity of each cell. This type of indicator can 
present an image of the supply of, or demand for, certain land uses by other land uses within a 
specified radius. 

Process description 

Each land use is assigned two weights; one for the numerator and one for the denominator of 
the values that will be calculated. For each cell, we then accumulate the weight of the 
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occurring land use in each cell within the neighbourhood of the current cell – the size of 
which is defined by the search radius parameter – for both numerator and denominator. The 
numerator and denominator are divided to obtain a single value per cell. If the denominator in 
a cell equals 0, the value in that cell will be set to ‘no data’. 

Algorithm 

for each cell c on the map 
initialise numerator and denominator to 0 
for each cell c’ in the neighbourhood of cell c 

add the weights to the numerator and denominator 
end for 

set the value of cell c to 
numerator

denominator
  if both are positive or else to ‘no data’ 

end for  

Parameters, input and output 
Table 3-29 Neighbourhood indicator parameters 

Name Description 
Search radius (cells) The radius in cells within which the algorithm looks for a land use that will be 

added to the numerator, denominator, or both. By default the minimum value 
for this parameter is 1 and the maximum is 25. A value of 1 will only count the 
current cell. The default value for this parameter is 10. 

Numerator The weight with which the corresponding land use will be added to the 
numerator. These values can range from 0 to 1000 and are set to 0 by default. 

Denominator The weight with which the corresponding land use will be added to the 
denominator. These values can range from 0 to 1000 and are set to 0 by default. 

3.2.4 Distance indicator 

Purpose and use 

This type of indicator approximates the smallest distance from each cell occupied by one of a 
set of land uses to a cluster of cells that are occupied by a different set of land uses. The 
minimum size of a cluster can be specified and the measure of distance can be adjusted. 

Process description 

The distance between each pair of cells is approximated by taking paths from one cell to 
another that is horizontally, vertically or diagonally adjacent. This approximation 
overestimates the actual distance by less than 10%. 

We calculate for each source cell the smallest distance to a cell that is in the centre of a cluster 
of target cells. A cell is a source cell if it is occupied by a land use marked as source. Idem for 
target cells. The centre cells of a cluster are those cells, for which all cells in the 
neighbourhood are target cells. 

Cells that contain a link type that is indicated to be an obstacle are not target cells, even if the 
land use that occupies the cell is marked as a target. 
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Algorithm 

let  ( )v c  denote the value of cell c. 
set all cell values to ‘no data’ 
for each cell c that is occupied by a land use indicated as ‘target’ and does not 
contain a link type that is an obstacle 

if all cells in the neighbourhood of cell c are occupied by a land use indicated as 
‘target’ and do not contain a link type that is an obstacle 

( ) 0v c =   
end if 

end for 
put all cells with value 0 in list L 
while L ≠ ∅  

remove the first cell c from list L 
for each cell d that is horizontally or vertically adjacent to cell c 

if ( ) ( )v c cellsize v d+ <  

( ) ( )v d v c cellsize= +  
add d to the end of list L 

end if 
end for 
for each cell d that is diagonally adjacent to cell c 

if ( ) ( )2v c cellsize v d+ ⋅ <  

( ) ( ) 2v d v c cellsize= + ⋅  
add d to the end of list L 

end if 
end for 

end while 
for each cell c that is occupied by a land use that is not indicated as ‘source’ 

set the value of cell c to ‘no data’ 
end for  

Parameters, input and output 
Table 1-1 Distance indicator parameters 

Name Description 
Road is obstacle Determines whether a road can intersect a target cluster (checked) or not 

(unchecked). By default this is checked. 
Target cluster radius This is the minimum size that a cluster of target cells should have to be 

considered a target. This value can range from 1 to 25 and is set to 10 by 
default. 

Role of land use Per land use you can specify whether it is a source, a target or neither (n.a.). 

3.2.5 Distance to map indicator 

Purpose and use 

This type of indicator approximates the distance from a cell with a certain land use to the 
nearest target cell, specified on an ancillary binary map. As in the distance indicator, one can 
specify the measure of distance. However, the distance is measured to the closest target cell, 
not the closest target cluster. 
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Process description 

The distance between each pair of cells is approximated by taking paths from one cell to 
another that is horizontally, vertically or diagonally adjacent. This approximation 
overestimates the actual distance by less than 10%. 

We calculate for each source cell the smallest distance to a cell that has a positive value in the 
ancillary map. A cell is a source cell if it is occupied by a land use marked as source. 

Algorithm 

let  ( )v c  denote the value of cell c. 

let cA  denote the value of cell c in the ancillary map. 
for each cell c 

( )
0 if 0
'no data' otherwise

cA
v c

>⎧
= ⎨
⎩

 

end for 
put all cells with value 0 in list L 
while L ≠ ∅  

remove the first cell c from list L 
for each cell d that is horizontally or vertically adjacent to cell c 

if ( ) ( )v c cellsize v d+ <  

( ) ( )v d v c cellsize= +  
add d to the end of list L 

end if 
end for 
for each cell d that is diagonally adjacent to cell c 

if ( ) ( )2v c cellsize v d+ ⋅ <  

( ) ( ) 2v d v c cellsize= + ⋅  
add d to the end of list L 

end if 
end for 

end while 
for each cell c that is occupied by a land use that is not indicated as ‘source’ 

set the value of cell c to ‘no data’ 
end for  

Parameters, input and output 
Table 1-2 Distance to map indicator parameters 

Name Description 
Range for counting 
cells 

Only count cells with the specific value. 

Source Sets for each land use whether the distance to the target areas should be shown 
or not. By default, all sources are unchecked. 

Area file Specifies the path and filename of a binary map file specifying the areas to 
which the distance should be calculated. Unless a proper file is specified, the 
indicator cannot be calculated. 
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3.2.6 Mask/mapping indicator 

Purpose and use 

This type of indicator can be used to analyse whether special areas are coinciding with (are 
disturbed by) certain land uses and display in a particular area. 

Process description 

For each cell that has a positive value in the ancillary map, the value in that cell is set to the 
weight of the land use that currently occupies the cell. 

Algorithm 

let cA  denote the value of cell c in the ancillary map. 
for each cell c 

if 0cA >  
set the value of cell c to the weight of the land use that occupies cell c 

else 
set the value of cell c to ‘no data’ 

end if 
end for  

Parameters, input and output 
Table 1-3 Mask/mapping indicator parameters 

Name Description 
Disturbance value The value of the disturbance can range from 0 to 25 and is set to 0 by default. 
Range for counting 
cells 

Only count cells with the specific value for mask/mapping indicator. 

3.2.7 Land use change indicator 

Purpose and use 

This type of indicator can be used to display particular land use changes between a base year 
and the current year in particular areas. 

Process description 

The current land use map is compared to the land use map for a base year, which can be 
entered in the indicator. The resulting value can be specified for each possible combination of 
a land use in the base year and in the current year. The results can be limited to a specific area 
with the use of an ancillary map to indicate the area or with the use of the suitability map for a 
particular land use to indicate suitable areas. 
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Algorithm 

for each cell c 
mask = 0 
if suitability is used as mask 

if the value of cell c in the selected suitability map ≥  threshold 
mask = 1 

end if 
else 

if the value of cell c in the mask map > 0 
mask = 1 

end if 
end if 
if mask = 1 

the value in cell c is set to the value in the table for the land use in cell c of 
the base map (from) and the current land use in cell c (to) 

end if 
end for  

Parameters, input and output 
Table 1-4 Land use change indicator input 

Name Description Source 
Initial land 
use map 

The land use map for the base year. MBB Land 
Use 

Table 1-5 Land use change indicator parameters 

Name Description 
Metric The measure of spatial patterns to use. 
Land use change 
classification 

The value that will be displayed in the result map if the cell has land use from 
in the base map and to in the current land use map. A value of -1 will result in a 
‘no data’ value. 

3.2.8 Spatial metric indicator 

Purpose and use 

This indicator can be used to derive a number of measures of spatial patterns from the land 
use map. 

Process description 

The indicator uses the algorithms of the ‘Moving Window Based Structure’ in the MAP 
COMPARISON KIT. The result map is the metric map produced by this method with the land 
use map as input. See the MAP COMPARISON KIT user manual for a more detailed 
description of the measures of spatial patterns. 

Algorithm 

See the MAP COMPARISON KIT user manual for a description of the measures of spatial 
patterns. 

Parameters, input and output 

Name Description 
Metric The measure of spatial patterns to use. 
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3.3 MBB Regional interaction 

3.3.1 Description MBB Regional interaction 

Objective  

This model divides the total population, jobs in main economic sectors for the whole study 
area over the regions based on their relative attractiveness. 

User information  
Table 3-30 User information in the Regional interaction model 

Drivers and 
Impacts 

Links to/from other MBB 

External 
influences 

Social-economic trend: number of jobs in main economic sectors per region; 
population per region. 
MBB Land Use: information on physical suitability, available space, 
accessibility and spatial configuration. 

Policy options Options of restricting the level of activity 
Other user options Weighing factors for the calculation of the attractivity and the productivity. 
Policy indicators Number of people and population density per region 

Number of jobs and their density in main economic sector per region 

General information 
Table 3-31 General information in the Regional interaction model 

Type of information Description 
Type of model Spatial interaction model, gravity model. 
Application Regions inside of the modelling area 
Spatial resolution Depending on the application case 
Temporal resolution Year 

Process description 

The regional model applied here models the levels of activity in different socio-economic 
sectors that in turn form a restriction on the cell allocation algorithm of the CA model. 
Specifically, the levels of activity are converted to a number of cells that needs to be allocated 
to each land use function by the CA model. The level of activity in a sector and region can be 
expressed in terms of the number of jobs, if we are dealing with an economic sector, or in 
terms of the number of people, if we are dealing with a population sector. 

The approach builds on an existing spatial interaction model (White) that has been used in 
previous projects and products (ENVIRONMENT EXPLORER, XPLORAH, MOLAND and 
METRONAMICA. In MOLAND-LIGHT it is used to convert the total population per region to 
the regional demands for residential area. The migration between regions is not simulated in 
MOLAND-LIGHT. In this section the full regional model will be described, In the calibration 
section it is discussed what elements of the regional model are used in MOLAND-LIGHT.   

The allocation of the growth amongst the regions depends to a large extent on the relative 
attractiveness of each of the region. In modelling the national socio-economic growth and 
migration distance also plays a crucial role. The underlying assumption for this is that regions 
can benefit from other attractive regions, as long as the distance is not too far. Furthermore, 
people and jobs are reluctant to migrate over greater distances. 

The attractiveness for the socio-economic sectors (population, jobs in main economic sectors) 
is based on the existing socio-economic activity in the study area as well as regional and local 
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characteristics. Local characteristics that can be taken into account are the suitability for 
different land use functions, the available space and the local accessibility.  

Constraints 

• The spatial interaction component of the model is based on the underlying assumption 
that the different regions have centres of gravity (cities) that are in competition with 
one another. Since the data is organised by administrative regions rather than by 
centres of gravity unexpected problems can occur that have an impact on the results. 

Equation, rules or algorithm  

Figure 3-7 explains the relations between the different components of the regional interaction 
model and its relation to the other models incorporated in the full MOLAND system. 
Elements in black are included in the regional interaction model; elements in grey represent 
components of the MOLAND system that provide input to the regional interaction model. 
The arrows show the flows of information, black arrows represent current values and dashed 
arrows lagged values (values from the previous time step). 

 
Figure 3-7 The relations between the different components of the regional interaction model 

and its relation to the other models incorporated in MOLAND 

The equations used in the regional interaction model are described in the sub-sections of this 
the section. Each of the elements in black –Activity, National growth, Migration, Attractivity 
for activity in all sectors, Productivity and Cell demands per land use– is described in a 
separate the section.  

Parameters  
Table 3-32 Parameters used in the Regional interaction model 

Name Description Unit 

kϕ  
The inertia for sector k - 

1,kβ  
Influence of the population potential on the attractivity of a region 
for activity k. 

- 

2,kβ  
Influence of the job potential on the attractivity of a region for 
activity k. 

- 

Social-economic trend 

Cell demands per 
land use 

Regional attractivity 
for activity in all 

sectors 

Local land use 

Regional productivity

Migration 

National growth 

Regional Activity  
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Name Description Unit 

3,kβ  
Influence of activity in economic sector k on the attractivity of a 
region for activity k. 

- 

4,kβ  
Influence of the land productivity on the attractivity of a region for 
activity k. 

- 

5,kβ  Influence of the activity on the fraction of national growth for 
sector k 

- 

6,kβ  
Influence of neighbourhood effect on the attractivity of a region 
for activity k. 

- 

7,kβ  
Influence of suitability on the attractivity of a region for activity k. - 

8,kβ  
Influence of zoning on the attractivity of a region for activity k. - 

9,kβ  Influence of the immigration-emigration ratio on the fraction of 
national growth for sector k 

- 

10,kβ  
Influence of accessibility on the attractivity of a region for activity 
k. 

- 

kn  The distance decay for sector k  

,f kF  The fraction of land use function f that contributes to sector k. - 

kWmin  
Minimum guaranteed level of cell-productivity in each region for 
sector k.  

Number of people or 
jobs / cell 

1,
t

kδ
 

Coefficient that determines the growth of the average cell-
productivity in a region for sector k. 

- 

3,kδ  Coefficient for the growth in activity – the ratio of current activity 
and lagged activity – in a region i for sector k. 

- 

5,kδ  Coefficient of the crowding effect in a region for sector k. - 

Input  
Table 3-33 Input used in the Regional interaction model 

Name Description Unit 
 Demand for jobs in the main economic sectors per region Number of jobs 
 Demand for population per region Number of people  

,
t

f cR  The neighbourhood effect of land use function f in cell c - 

( )t f c  The current land use map; the land use that occupies cell c at time 
t 

- 

,
t

f cS  The suitability effect of land use function f in cell c at time t - 

,
t

f cZ  The zoning effect of land use function f in cell c at time t - 

,
t

f cA  The accessibility effect of land use function f in cell c at time t - 

Distance between region i and region j at time t Km 
,

t
i jd  

Generalised costs from the origin region i to the destination region 
j at time t 

Currency 

Output  
Table 3-34 Output given in the Regional interaction model 

Name Description Unit 

,
t

k iX  The activity in sector k and region i at time t  Number of people or 
jobs 

,
t

f iN  The cell demand of land use function f in region i at time t  Number of cells 

, ,
t

k i jM  The migration; The number of people in sector k that move from 
region i to region j at time t  

Number of people or 
jobs 
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3.3.2 Activity 

Purpose and use 

This model block keeps track of the level of activity, i.e. the number of jobs and people in 
economic and population sectors, respectively. The initial count is taken from data. 

Process description 

The level of activity in a region is composed of the inert activity, the immigrated activity and 
a part of the overall (national) growth of activity.  

Algorithm 

The function, which determines the level of activity, looks as follows: 
1

, , , , ,
t t t t

k i k k i k j i k i
j

X X M Eϕ −= ⋅ + +∑
 

Parameters, input and output 
Table 3-35 Parameters used in the activity model block 

Name Description Unit 

kϕ  
The inertia for sector k - 

Table 3-36 Input variables used in the activity model block 

Name Description Unit 
1

,
t

k iX−  The activity in sector k and region i at time t-1 (previous time step)  Number of 
people or jobs 

, ,
t

k i jM  The migration; The activity in sector k that move from region i to 
region j at time t  

Number of 
people or jobs 

,
t

k iE  The fraction of national growth of activity in sector k that ends up in 
region i at time t  

Number of 
people or jobs 

Table 3-37 Output variables given by the activity model block 

Name Description Unit 

,
t

k iX  The activity in sector k and region i at time t  Number of 
people or jobs 

3.3.3 National growth 

Purpose and use 

This model block determines the part of the national activity growth, which will end up in a 
region. The determination of the size of a part is solely based on the ongoing migrations.   

Process description 

The absolute national growth in a sector can be calculated by taking the difference of the 
current level of activity and the lagged level of activity. In order to determine the part of the 
national growth that will end up in one region, the migrations are taken into account. Here, 
the relative size of the immigration over emigration ratio matters. This is intuitive. A region 
with many immigrants and few emigrants experiences a growth of activity, accompanied by a 
great share of the national growth. 
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Algorithm 

An intermediate variable is the immigration-emigration ratio, which is specific to each sector 
k and region i at time t. It is determined by the following formula: 

, ,

,
, ,

t
k j i

jt
k i t

k i j
j

M
MR

M
=
∑
∑

 

The function, which determines the value of the output variable, looks as follows: 

5, 9,

5, 9,

1
, , 1

, 1
, ,

( )
k k

k k

t t
k i k it t t

k i k kt t
k j k j

j

X MR
E NA NA

X MR

β β

β β

−
−

−

⋅
= ⋅ −

⋅∑
 

Parameters, input and output 
Table 3-38 Parameters used in the national growth model block 

Name Description Unit 

5,kβ  Influence of the activity on the fraction of national growth for sector k - 

9,kβ  Influence of the immigration-emigration ratio on the fraction of 
national growth for sector k 

- 

Table 3-39 Input variables used in the national growth model block 

Name Description Unit 
1

,
t

k iX−  The activity in sector k and region i at time t-1 (previous time step)  Number of 
people or jobs 

, ,
t

k i jM  The migration; The number of people in sector k that move from 
region i to region j at time t  

Number of 
people or jobs 

t
kNA  The total level of activity in sector k at time t  Number of 

people or jobs 
1t

kNA−  The total level of activity in sector k at time t-1 (previous time step)  Number of 
people or jobs 

Table 3-40 Output variables given by the national growth model block 

Name Description Unit 

,
t

k iE  The fraction of national growth of activity in sector k that ends up in 
region i at time t  

Number of 
people or jobs 

3.3.4 Migration 

Purpose and use 

This model block determines the migration within a sector from one region to another. This 
information is primarily used in the activity model block.  

Process description 

The migration from one region to another is the product of the not inert activity of the former 
and the relative attractivity of the latter – relative to the attractivity of the other regions. The 
relative attractivity weighs the attractivities of the different regions in accordance to the 
interregional distances. 

Algorithm 

The function, which determines the value of the output variable, looks as follows: 
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Parameters, input and output 
Table 3-41 Parameters used in the migration model block 

Name Description Unit 

kn  The distance decay for sector k - 

Table 3-42 Input variables used in the migration model block 

Name Description Unit 
The distance between region i and region j at time t km 

,
t

i jd  

The generalised cost is expressed as the distance between region i and 
region j at time  

Currency 

1
,

t
k iX−  The activity in sector k and region i at time t-1 (previous time step)  Number of 

people or jobs 

,
t

k iT  The attractivity of region i on sector k at time t - 

kϕ  
The inertia for sector k - 

Table 3-43 Output variables given by the migration model block 

Name Description Unit 

, ,
t

k i jM  The migration; The number of people in sector k that move from 
region i to region j at time t  

Number of 
people or jobs 

3.3.5 Attractivity for activity in all sectors 

Description of the attractivity model block 

Purpose and use 

This model block determines the attractivity of a region on a sector. The dimension of this 
variable is irrelevant, as only relative attractivity matters. 

Process description 

The attractivity captures different factors. One set of factors are the different potentials, 
namely population, job and activity. The idea is that the more potential a region has the more 
attractive it is. In addition, the productivity plays a role. Lastly, the local characteristics, 
namely neighbourhood effect, suitability, zoning and accessibility, influence the attractivity of 
a region. 

Algorithm 

The function, which determines the value of the output variable, looks as follows: 
1, 2, 3, 4, 6, 7 , 8, 10,1 1 1 1 1

, , , , , , , , ,
k k k k k k k kt t t t t t t t t

k i k i k i k i k i k i k i k i k iT VP VJ V W R S Z Aβ β β β β β β β− − − − −= ⋅ ⋅ ⋅ ⋅ ⋅ ⋅ ⋅  

Parameters, input and output 
Table 3-44 Parameters used in the attractivity model block 

Name Description Unit 

1,kβ  
Influence of the population potential on the attractivity of a region 
for activity k. 

- 

2,kβ  
Influence of the job potential on the attractivity of a region for 
activity k. 

- 
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Name Description Unit 

3,kβ  
Influence of activity in economic sector k on the attractivity of a 
region for activity k. 

- 

4,kβ  
Influence of the land productivity on the attractivity of a region for 
activity k. 

- 

6,kβ  
Influence of neighbourhood effect on the attractivity of a region for 
activity k. 

- 

7,kβ  
Influence of suitability on the attractivity of a region for activity k. - 

8,kβ  
Influence of zoning on the attractivity of a region for activity k. - 

10,kβ  
Influence of accessibility on the attractivity of a region for activity k. - 

Table 3-45 Input variables used in the attractivity model block 

Name Description Unit 

,
t

k iVP  Population potential in sector k and region i at time t - 

,
t

k iVJ  Job potential in sector k and region i at time t - 

,
t

k iV  Activity potential in sector k and region i at time t - 

1
,

t
k iW−  The productivity of sector k in region i at time t-1 (previous time 

step) (unit: # people or jobs / cell) 
Number of people 
or jobs 

1
,

t
k iR−  The average neighbourhood effect of sector k in region i at time t - 

1
,

t
k iS−  The average suitability of sector k in region i at time t - 

1
,

t
k iZ−  The average zoning of sector k in region i at time t - 

1
,

t
k iA−  The average accessibility of sector k in region i at time t - 

Table 3-46 Output variables given by the attractivity model block 

Name Description Unit 

,
t

k iT
 

The attractivity of region i on sector k at time t - 

The population potential model block 

Purpose and use 

This model block determines the population potential per region per sector.  

Process description 

The population potential per region and sector is a function of the sums of population 
activities, i.e. the number of people, in all regions and the distances between the regions. 

Algorithm 

The function, which determines the value of the output variable, looks as follows: 

( )( ) 11
, , ,2

knt t t t
k i i j j i j

j
VP d d XP

−
−= + ⋅∑  

, while: 
1 1

,
P

t t
i k i

k K
XP X− −

∈

= ∑  

Here, pK  is the set of all population sectors. 
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Parameters, input and output 
Table 3-47 Parameters used in the population potential model block 

Name Description Unit 

kn  The distance decay for sector k - 

Table 3-48 Input variables used in the population potential model block 

Name Description Unit 
The distance between region i and region j at time t km 

,
t

i jd  

The generalised cost is expressed as the distance between region i and 
region j at time t 

Currency 

1
,

t
k iX−  The activity in sector k and region i at time t-1 (previous time step)  Number of 

people 

Table 3-49 Output variables given by the population potential model block 

Name Description Unit 

,
t

k iVP  The population potential in sector k and region i at time t - 

The job potential model block 

Purpose and use 

This model block determines the job potential per region per sector.  

Process description 

The job potential per region and sector is a function of the sums of job activities, i.e. the 
number of jobs, in all regions and the distances between the regions. 

Algorithm 

The function, which determines the value of the output variable, looks as follows: 

( )( ) 11
, , ,2

knt t t t
k i i j j i j

j

VJ d d XJ
−

−= + ⋅∑  

, while: 
1 1

,
e

t t
i k i

k K
XJ X− −

∈

= ∑  

Here, eK  is the set of all economic sectors. 

Parameters, input and output 
Table 3-50 Parameters used in the job potential model block 

Name Description Unit 

kn  The distance decay for sector k - 

Table 3-51 Input variables used in the job potential model block 



 

 80

Name Description Unit 
The distance between region i and region j at time t km 

,
t

i jd  

The generalised cost is expressed as the distance between region i and region j 
at time t 

Currency 

1
,

t
k iX−  The activity in sector k and region i at time t-1 (previous time step)  Number 

of jobs 

Table 3-52 Output variables given by the job potential model block 

Name Description Unit 

,
t

k iVJ  The job potential in sector k and region i at time t - 

The activity potential model block 

Purpose and use 

This model block determines the activity potential per region per sector.  

Process description 

The activity potential per region and sector is a function of the level of activities in the same 
sector but in different regions in relation to the distances between the regions. 

Algorithm 

The function, which determines the value of the output variable, looks as follows: 

( )( ) 11
, , , ,2

knt t t t
k i i j j i k j

j

V d d X
−

−= + ⋅∑  

Parameters, input and output 
Table 3-53 Parameters used in the activity potential model block 

Name Description Unit 

kn  The distance decay for sector k - 

Table 3-54 Input variables used in the activity potential model block 

Name Description Unit 
The distance between region i and region j at time t km 

,
t

i jd  

The generalised cost is expressed as the distance between region i and 
region j at time t 

Currency 

1
,

t
k iX−  The activity in sector k and region i at time t-1 (previous time step)  Number of 

people or jobs 

Table 3-55 Output variables given by the activity potential model block 

Name Description Unit 

,
t

k iV  The activity potential in sector k and region i at time t - 

The sector to land use conversion model block 

Purpose and use 

This model block calculates the cell demand of a land use function in a region, given the cell 
demand of a sector in a region.  
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Process description 

Based on a fixed predetermined function-sector correspondence, the inverse correspondence 
from sector to function has to be determined at each time step. It is not fixed. This is due to 
the constraint that both cell demands have to be integer numbers. Thus, at each time step, 
little variations occur due to rounding. The inverse correspondence indicates the fraction, for 
which a sector accounted in a land use function in the previous time step. Then in accordance 
to this fraction the newly determined cell demand of a sector in a region is translated into the 
cell demand of a land use function. The sum over all sectors that correspond to this land use 
function then gives the total cell demand of the latter. 

Algorithm 

The function, which determines the value of the output variable, looks as follows: 
1

, , , ,
t t t inv

f i k i i f k
k K

N N F−

∈

= ⋅∑  

with: 
1

, ,1
, , 1

,

t
f i f kt inv

i f k t
k i

N F
F

N

−
−

−

⋅
=  

Here, K  is the set of all sectors. 

Parameters, input and output 
Table 3-56 Parameters used in the Sector to Land use conversion model block 

Name Description Unit 

,f kF  The fraction of land use function f that contributes to sector k. - 

Table 3-57 Input variables used in the Sector to Land use conversion model block 

Name Description Unit 
1

,
t

k iN−  The cell demand of sector k in region i at time t-1 (previous time step)  Number of cells 

,
t

k iN  The cell demand of sector k in region i at time t Number of cells 

Table 3-58 Output variables given by the Sector to Land use conversion model block 

Name Description Unit 

,
t

f iN  The cell demand of land use function f in region i at time t  Number of cells 

The neighbourhood conversion model block 

Purpose and use 

This model block determines the neighbourhood effect that is present in a region and in a 
sector. As input the neighbourhood effect of a cell on a land use function is given.  

Process description 

The neighbourhood effect given per cell is aggregated (summed up) for a region and then 
transformed from land use function to sector by means of the function – sector 
correspondence. In order to rescale the effect appropriately, the aggregated effect is divided 
by the number of cells that belongs to the corresponding sector in a particular region. 

Algorithm 

The function, which determines the value of the output variable, looks as follows: 
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Here, FLU  is the set of all function land uses, iC  is the set of all cells c in region i. 

Parameters, input and output 
Table 3-59 Input variables used in the neighbourhood conversion model block 

Name Description Unit 

,f kF  The fraction of land use function f that contributes to sector k. - 

,
t

f iN  The cell demand of land use function f in region i at time t  Number of 
cells 

,
t

f cR  The neighbourhood effect of land use function f in cell c - 

( )t f c  The current land use map; the land use that occupies cell c at time t - 

Table 3-60 Output variables given by the neighbourhood conversion model block 

Name Description Unit 

,
t

k iR  The average neighbourhood effect of sector k in region i at time t - 

The suitability conversion model block 

Purpose and use 

This model block determines the suitability of a region for a sector. As input the suitability of 
a cell for a land use function is given.  

Process description 

The suitability given per cell is aggregated (summed up) for a region and then transformed 
from land use function to sector by means of the function – sector correspondence. In order to 
rescale the suitability appropriately, the aggregated suitability is divided by the number of 
cells that belongs to the corresponding sector in a particular region.  

Algorithm 

The function, which determines the value of the output variable, looks as follows: 

( )
, ,

t
,

, ,

t
F i

F

f k f c
f LU c C f c f

k i t
f k f i

f LU

F S

S
F N

∈ ∈ =

∈

⎛ ⎞
⎜ ⎟⋅
⎜ ⎟
⎝ ⎠=

⋅

∑ ∑

∑
 

Here, FLU  is the set of all function land uses, iC  is the set of all cells c in region i. 

Parameters, input and output 
Table 3-61 Input variables used in the suitability conversion model block 
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Name Description Unit 

,f kF  The fraction of land use function f that contributes to sector k. - 

,
t

f iN  The cell demand of land use function f in region i at time t  Number of 
cells 

,
t

f cS  The suitability effect of land use function f in cell c - 

( )t f c  The current land use map; the land use that occupies cell c at time t - 

Table 3-62 Output variables given by the suitability conversion model block 

Name Description Unit 

,
t

k iS  The average suitability effect of sector k in region i at time t - 

The zoning conversion model block 

Purpose and use 

This model block determines the zoning of a region for a sector. As input the zoning of a cell 
for a land use function is given.  

Process description 

The zoning given per cell is aggregated (summed up) for a region and then transformed from 
land use function to sector by means of the function – sector correspondence. In order to 
rescale the zoning appropriately, the aggregated zoning is divided by the number of cells that 
belongs to the corresponding sector in a particular region. 

Algorithm 

The function, which determines the value of the output variable, looks as follows: 
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Here, FLU  is the set of all function land uses, iC  is the set of all cells c in region i. 

Parameters, input and output 
Table 3-63 Input variables used in the zoning conversion model block 

Name Description Unit 

,f kF  The fraction of land use function f that contributes to sector k. - 

,
t

f iN  The cell demand of land use function f in region i at time t  Number of 
cells 

,
t

f cZ  The zoning effect of land use function f in cell c - 

( )t f c  The current land use map; the land use that occupies cell c at time t - 

Table 3-64 Output variables given by the zoning conversion model block 
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Name Description Unit 

,
t

k iZ  The average zoning effect of sector k in region i at time t - 

The accessibility conversion model block 

Purpose and use 

This model block determines the accessibility of a region for a sector. As input the 
accessibility of a cell for a land use function is given.  

Process description 

The accessibility given per cell is aggregated (summed up) for a region and then transformed 
from land use function to sector by means of the function – sector correspondence. In order to 
rescale the accessibility appropriately, the aggregated accessibility is divided by the number 
of cells that belongs to the corresponding sector in a particular region.  

Algorithm 

The function, which determines the value of the output variable, looks as follows: 
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Here, FLU  is the set of all function land uses, iC  is the set of all cells c in region i. 

Parameters, input and output 
Table 3-65 Input variables used in the accessibility conversion model block 

Name Description Unit 

,f kF  The fraction of land use function f that contributes to sector k. - 

,
t

f iN  The cell demand of land use function f in region i at time t  Number of cells 

,
t

f cA  The accessibility effect of land use function f in cell c at time t - 

( )t f c  The current land use map; the land use that occupies cell c at time t - 

Table 3-66 Output variables given by the accessibility conversion model block 

Name Description Unit 

,
t

k iA  The average accessibility effect of sector k in region i at time t - 

3.3.6 Productivity 

The levels of activity form a restriction on the cell allocation in the CA model. To be more 
precise, the demand for activity can be converted to a number of cells that needs to be 
allocated to a sector by modelling the average activity per cell in a region – this is known as 
the productivity. The number of cells allocated to each sector can in turn be converted to a 
number of cells that needs to be allocated to each land use class – note that sectors and land 
use classes are not necessarily equivalent. This is related to the allocation algorithm of the 
MBB Land Use. 
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Overview productivity model block 

Purpose and use 

This model block determines the productivity of a sector in a region, i.e. the number of jobs or 
people per cell.  

Process description 

The productivity takes into account the assumption of a continuous growth. Further, the 
productivity depends on its own past. For instance, if the productivity was high last year, it is 
likely to be high this year as well. Another factor in the determination of the productivity is 
the growth of activity. A last factor is the so called crowding effect. This occurs, if the 
number of cells in a region is not sufficient anymore to accommodate the demand for cells.  

Algorithm 

The function constitutes the initial value as follows, which determines the value of the output 
variable: 

0
,0

, 0
,

k i
k i

k i

X
W

N
= . 

Parameters, input and output 
Table 3-67 Parameters used in the productivity model block 

Name Description Unit 

kWmin  
Minimum guaranteed level of cell-productivity in each region for 
sector k.  

Number of people 
or jobs / cell 

1,
t

kδ
 

Coefficient that determines the growth of the average cell-
productivity in a region for sector k. 

- 

3,kδ  Coefficient for the growth in activity – the ratio of current activity 
and lagged activity – in a region i for sector k. 

- 

5,kδ  Coefficient of the crowding effect in a region for sector k. - 

Table 3-68 Input variables used in the productivity model block 

Name Description Unit 
1

,
t

k iW−  The productivity of sector k in region i at time t-1 (previous time 
step) 

Number of people 
or jobs / cell 

,
t

k iX  The activity in sector k and region i at time t  Number of people 
or jobs  

1
,

t
k iX−  The activity in sector k and region i at time t-1 (previous time step) Number of people 

or jobs 
t

iQ  The crowding effect in region i at time t - 

Table 3-69 Output variables given by the productivity model block 

Name Description Unit 

,
t

k iW  The productivity of sector k in region i at time t  Number of people 
or jobs / cell 

The crowding effect model block 

Purpose and use 

This model block calculates the crowding effect. The purpose is to account for the situation, 
where demand for cells is actually higher than the number of available cells.   
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Process description 

The crowding effect can occur in a region, if the cell demand of all land use functions, i.e. 
economic and population, is larger then the number of cells in a region (that are not features), 
i.e. cells that can be occupied by a land use function. The cell demand is approximated by the 
ratio of the current activity over the lagged productivity, as the current productivity is not 
available. In fact, its computation is using the crowding effect. 

Algorithm 

The function, which determines the value of the output variable, looks as follows: 
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Here, EPK  is the set of all sectors and VFLU  is the set of all vacant and function land uses. 

Parameters, input and output 
Table 3-70 Input variables used in the crowding effect model block 

Name Description Unit 

,
t

k iX  The activity in sector k and region i at time t  Number of 
people or jobs 

1
,

t
k iW−  The productivity of sector k in region i at time t-1 (previous time step)  Number of 

people or jobs 
1t

iAS−  The available space in region i at time t-1 (previous time step)  Number of 
cells 

Table 3-71 Output variables given by the crowding effect model block 

Name Description Unit 
t

iQ  The crowding effect in region i at time t - 

The available space model block 

Purpose and use 

This model block determines the available space, i.e. the number of cells that is not classified 
as a feature, in a region.  

Process description 

It is a matter of counting the cells in a region that are either occupied by a land use function or 
vacant. 

Algorithm 

The function, which determines the value of the output variable, looks as follows: 

( ) ,

t 1
t

i F V

i
c C f c LU
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∈ ∈

= ∑  

Here, ,F VLU  is the set of all vacant and function land uses, iC  is the set of all cells c in 
region i. 

Parameters, input and output 
Table 3-72 Input variables used in the available space model block 



 

 87

Name Description Unit 
( )t f c  The current land use map; the land use that occupies cell c at time t - 

Table 3-73 Output variables given by the accessibility conversion model block 

Name Description Unit 
t

iAS  The available space in region i at time t Number of cells 

3.3.7 Cell demands per land use 

Purpose and use 

This model block calculates the cell demand per sector per region. This cell demand is 
important to determine the number of cells, which will eventually be allocated in the CA-
model.  

Process description 

The cell demand is computed as the ratio of activity over productivity, rounded to the nearest 
integer. The intuition is clear. If the activity is very high, but the productivity is low, then a lot 
of cells are needed in order to accommodate the activity.  

Algorithm 

The function, which determines the value of the output variable ,
t

k iN  for all land uses expect 
agriculture, looks as follows: 

,
,

,
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Parameters, input and output 
Table 3-74 Input variables used in the cell demand model block 

Name Description Unit 

,
t

k iX  The activity in sector k and region i at time t  Number of people or jobs 

,
t

k iW  The productivity of sector k in region i at time t  Number of people or jobs per cell 

Table 3-75 Output variables given by the cell demand model block 

Name Description Unit 

,
t

k iN  The cell demand of sector k in region i at time t Number of cells 

 

 





 

 

4. Data preparation and calibration 

This section describes the calibration of MOLAND-LIGHT. This includes the data that was 
used for the application, the general calibration procedure, the calibration and validation 
results and the parameter set that was obtained from this. 

The MOLAND-LIGHT system uses exactly the same model and algorithms as the original 
MOLAND system and the Metronamica land use modelling framework. These model 
descriptions can be found in chapter 3 Model description. 

4.1 Model specification 
All applications in MOLAND-LIGHT use the same data set. This data, which is included in 
the system, is the result of processing of the available base data. For each input dataset, the 
source data as well as the processing is discussed shortly in this section. All raster maps are 
represented as a raster file with a resolution of 250 meter. 

4.1.1 Regions maps 

The regions used in MOLAND-LIGHT are the RUR regions as defined in the PLUREL 
project. RUR regions include one or more NUTS 3 regions. Therefore the RUR regions map 
was created from a NUTS 3 regions map. The dataset for RUR regions was provided by one 
of the PLUREL partners (Loibl W. et al, 2008.) . 

4.1.2 Land use maps 

Land use was taken from the Corine Land Cover (CLC) Database from the EEA (Copyright 
holder: European Environment Agency. Official access point to this data: 
http://epp.eurostat.ec.europa.eu/portal/page/portal/gisco/geodata/reference).  

For calibration and validation the applications started from the land use in 1990, CLC1990, 
and results were compared to the 2000 land use in CLC2000. The applications in MOLAND-
LIGHT start from CLC2000. Because CLC includes too many classes for the purpose of a 
simple modelling tool, the original land use was reclassified first according to the table below. 

MOLAND-LIGHT land use CLC Land uses (label 3) MOLAND-LIGHT 
type* 

Natural vegetation Natural grasslands, Moors and heathland, 
Sclerophyllous vegetation, Transitional 
woodland-shrub, Burnt areas 

Vacant 

Residential Continuous urban fabric, Discontinuous urban 
fabric, Construction sites** 

Function 

Industry and commerce Industry or commercial units, Construction 
sites** 

Function 



 

 

MOLAND-LIGHT land use CLC Land uses (label 3) MOLAND-LIGHT 
type* 

Agriculture Non-irrigated arable land, Permanently irrigated 
land, Rice fields, Vineyards, Fruit trees and berry 
plantations, Olive groves, Pastures, Annual crops 
associated with permanent crops, Complex 
cultivation patterns, Land principally occupied 
by agriculture with significant areas of natural 
vegetation, Agro-forestry areas 

Function 

Forest Broad-leaved forest, Coniferous forest, Mixed 
forest 

Function 

Road and railways Road and rail networks and associated land Feature 
Ports Port areas Feature 
Airports Airports Feature 
Mineral extraction and dump 
sites 

Mineral extraction sites, Dump sites Feature 

Parks and recreation areas Green urban areas, Sport and leisure facilities Feature 
Open spaces with little or no 
vegetation 

Beaches dunes and sands, Bare rocks, Sparsely 
vegetated areas, Glaciers and perpetual snow 

Feature 

Wetlands Inland marshes, Peat bogs, Salt marshes, Salines, 
Intertidal flats 

Feature 

Inland water Water courses, Water bodies Feature 
Marine water Coastal lagoons, Estuaries, Sea and ocean, 

Unclassified water bodies 
Feature 

No data No data, Unclassified land surface Feature 

*MOLAND-LIGHT characterizes each land use as vacant, function or feature. See chapter 3 
Model description for a further explanation. 

**Construction is reclassified into either residential or industrial and commercial land, 
depending on which of the two appears most in the direct surroundings 

4.1.3 Suitability maps 

Suitability maps are created for all function land uses. There is no suitability map for the 
vacant land use class, because there is only one vacant class and therefore no need to 
distinguish between the aptness of various locations for this class. 

The suitability maps used in MOLAND-LIGHT are the result of a two step process. First base 
maps are interpreted in terms of their suitability [0-10], and then these interpreted maps are 
combined in one overlay by means of a minimum function (hence the factor which poses the 
strongest limitation is selected). 

The base maps that were used to create suitability maps are agricultural limitation, elevation 
and slope. These data were provided by JRC. The dataset for slope and elevation are part of 
version 4 of SRTM data (Jarvis A. et al. 2008).  

The agricultural limitation data is from the European Soil Database (European Soil Database 
http://eusoils.jrc.ec.europa.eu/esdb_archive/ESDB/Index.htm).  

Distinct suitability maps have been developed for agriculture, forest and urban land use. 
Suitability maps for the urban categories Residential and Industry and commerce are the same 
as both are urban functions with comparable interest in physical characteristics of an area. 

4.1.4 Zoning maps 

Zoning maps are created for Residential and for Industry and commerce land uses only. The 
only zoning restrictions that were incorporated are locations that are defined as Natura 2000 



 

 

areas. On those locations no urban development is allowed. However, these maps were 
corrected for locations that already have an urban land use, to prevent removal thereof during 
the simulation, which is unlikely.  

The Natura 2000 data is coming from EEA (Copyright holder: European Environment 
Agency. The official access point to data: 
http://epp.eurostat.ec.europa.eu/portal/page/portal/gisco/geodata/reference).  

4.1.5 Transport networks 

Two networks are included, a road network and a rail network. As can be seen from the 
parameterization in the next section, it is not the actual rail network, but the location of the 
rail stations that influence the allocation of land uses.  

The transport network data are part of the EuroGlobalMap (©EuroGeographics. 
EuroGlobalMap (http://www.eurogeographics.org/products-and-services/euroglobalmap) for 
with JRC has a license. 

4.1.6 Land use demands 

Land use demands are included for Industrial and commercial land, Agriculture, and Forest. 
For the countries that are covered by CLC1990 and CLC2000 the land use demands for 2030 
are computed as a linear extrapolation of historic trends. For those countries that were not 
covered by CLC1990 (United Kingdom, Sweden, Finland), the average change of Germany 
was used. Germany was selected because it was large enough to provide a reasonable average 
and comparable as all countries are modern western economies. 

4.1.7 Population demands 

Population demands are taken from Eurostat for the years 1990 and 2000 as they were 
available at the NUTS 3 level and could therefore directly be used for the computation of the 
population in RUR regions.  

For 2030 only forecasts at NUTS 2 level were available, which were used for the population 
demands. For those RUR regions that include only parts of NUTS 2 regions, change was 
computed proportionally to the change in the larger NUTS 2 region it is located in.  

4.2 Calibration and validation procedure 
MOLAND-LIGHT was calibrated on four case regions and subsequently validated on four 
other case regions. These regions were chosen to represent both urban and rural areas from 
different countries in Europe as to avoid over calibration towards one particular urbanisation 
type. For calibration the regions Maastricht-Duren-Aachen (NL/DE), Warsaw (PL), Patras 
(HE), and Valencia (ES) were selected. For validation we selected Munich (DE), Veszprem 
(HU), Parma-Modena-Reg. Emilia (IT), and Talinn (EE). 

Land-use change models can be assessed based on several aspects, such as patterns or local 
accuracy. However, as patterns are really large-scale phenomena, the calibration and 
validation results were only tested with respect to their local accuracy (presence). For this we 
used the Kappa Simulation statistic (Van Vliet et al., in press), which yields values between -1 
and 1. Values above 0 indicate that the model does explain land use changes, while values 
below 0 indicate it does not. 



 

 

Besides optimization to Kappa Simulation, the calibration results were checked manually on 
realism. This means that all parameters included should be explicable in terms of their real 
world meaning, and that the calibration applications should be carefully examined for 
artefacts. Artefacts in this case are simulated land-use changes that are the result of incorrectly 
set parameters and therefore generate unrealistic results. 

It should be noted that the explicit aim of the calibration procedure is to obtain a set of 
parameters that yields reasonable results in all regions as opposed to good results in one or a 
selected number of case study regions. Therefore the tool can be used as a first investigation, 
while it is not intended for elaborate research on one area. 

4.3 Calibration and validation results 

The table below presents the Kappa Simulation scores for the applications that were used in 
the calibration and those were used for the independent validation. All applications were set 
up to simulate known land use changes for the period 1990 - 2000 and use exactly the same 
data sets and parameter set.  

All scores are above 0 which indicates that all applications do explain land use changes to 
some extent. Moreover, the validation applications are equally accurate as the calibration 
areas if not a little higher. This indicates that the system is not over calibrated towards a few 
regions, but instead that the parameter set is general. At the other hand, these results show that 
dynamics in urban areas are generally simulated with more accuracy than those in rural areas 
as both Patras and Veszprem yield lower scores compared to the more urban areas. 

Activity Region Kappa Simulation 
Maastricht – Aachen – Duren 0.29 
Valencia 0.24 
Patras 0.01 

Calibration 

Warsaw 0.09 
Talinn 0.47 
Munich 0.12 
Veszprem 0.08 

Validation 

Parma – Reg. Emilia - Modena 0.29 

4.4 Parameter set 

This section presents the parameters that are included in MOLAND-LIGHT. Each parameter 
is explained shortly, while a more elaborate explanation can be found in the model 
descriptions of the MOLAND model (see chapter 3). 

4.4.1 Regional model 

Population is converted into density in a way similar to the regional model in MOLAND, 
except that all applications have only one region. Therefore there is no migration and 
parameters related to migration are not included. The parameters that are included are listed 
below. 

Parameter Value 
Constant growth of density 1 
Exponent activity growth 0.3 
Exponent crowding 1 



 

 

4.4.2 Stochastic perturbation 

Land use is allocated according to the total potential of all locations for each land use. For this 
the same algorithm is used as in the full MOLAND system. The stochastic perturbation term 
in this algorithm is set to 0.5. 

4.4.3 Neighbourhood rules 

The neighbourhood rules describe the attraction or repulsion from one land use on the other as 
a function of the distance. The table below only describes those land-use interactions that are 
unequal to zero and therefore contribute to the land-use allocation. Distances are expressed in 
meters and values are interpolated linearly in between. 

Influence of on 0 250 500 750 1000 2000 
Natural vegetation Residential 0.5 0 0 0 0 0 
Natural vegetation Industry and commerce 0.5 0 0 0 0 0 
Natural vegetation Agriculture 0.5 0 0 0 0 0 
Natural vegetation Forest 1 0 0 0 0 0 
Residential Residential 250 5 0.25 0 0 0 
Residential Industry and commerce 0 0 0 1 0 0 
Industry and commerce Residential 0 0 0 1 0 0 
Industry and commerce Industry and commerce 250 5 0 0 0 0 
Agriculture Residential 8 0 0 0 0 0 
Agriculture Industry and commerce 8 0 0 0 0 0 
Agriculture Agriculture 9 0.5 0 0 0 0 
Agriculture Forest 1 0 0 0 0 0 
Forest Residential 1 0 0 0 0 0 
Forest Industry and commerce 1 0 0 0 0 0 
Forest Forest 25 1 0 0 0 0 

4.4.4 Accessibility 

The influence of accessibility is computed as a function of the distance to the nearest transport 
network and the relative importance of this network. These parameters are set for each 
function land use separately. However, in practice, accessibility mostly influences urban land 
use. Therefore the accessibility parameters are only set for the two urban land uses. Values are 
indicated in the table below. 

Land use Infrastructure type Distance decay [cells] Weight 
Residential Motorways 10 0.8 
Residential Main roads 6 0.6 
Residential Regional roads 2 0.4 
Residential Railways 1 0 
Residential Railway stations 10 1 
Industry and commerce Motorways 10 1 
Industry and commerce Main roads 10 0.7 
Industry and commerce Regional roads 6 0.4 
Industry and commerce Railways 1 0 
Industry and commerce Railway stations 10 0.5 

4.4.5 Suitability and zoning 

Parameter settings for suitability and zoning are described in sections 4.1.3 and 4.1.4. 
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